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Customer Support
You can obtain technical support by using the Support page on the BMC Software Web site or by contacting
Customer Support by telephone or e-mail. To expedite your inquiry, please see  “Before Contacting BMC
Software,” below.

Support Web Site

You can obtain technical support from BMC Software 24 hours a day, seven days a week by accessing the
technical support Web site athttp://www.bmc.com/support.html. From this site, you can

• read overviews about support services and programs that BMC Software offers
• find the most current information about BMC Software products
• search a database for problems similar to yours and possible solutions
• order or download product documentation
• report a problem or ask a question
• subscribe to receive e-mail notices when new product versions are released
• find worldwide BMC Software support center locations and contact information, including e-mail addres

fax numbers, and telephone numbers

Support via Telephone or E-mail

In the USA and Canada, if you need technical support and do not have access to the Web, call 800 537 181
Outside the USA and Canada, please contact your local support center for assistance. To find telephone and
contact information for the BMC Software support center that services your location, refer to the Contact
Customer Support section of the Support page on the BMC Software Web site atwww.bmc.com/support.html.

Before Contacting BMC Software

Before you contact BMC Software, have the following information available so that a technical support anal
can begin working on your problem immediately:

• product information

— product name
— product version (release number)
— license number and password (trial or permanent)

• operating-system and environment information

— machine type
— operating system type, version, and service pack or program temporary fix (PTF)
— system hardware configuration
— serial numbers
— related software (database, application, and communication) including type, version, and service p

PTF
BMC Software, Inc., Confidential and Proprietary Information
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• sequence of events leading to the problem

• commands and options that you used

• messages received (and the time and date that you received them)

— product error messages
— messages from the operating system, such asfile system full
— messages from related software
BMC Software, Inc., Confidential and Proprietary Information
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About This Book

This book contains detailed information about Service Reporting and
intended as a “read me first” document to help you install, configure, a
get started using the application. Use this book with accompanying
documents such as release notes, theDataStore Administrator Guide, and
theReporting User Guide.

In addition, BMC Software provides documentation for the Actuate
Software Corporation components and Oracle Corporation componen
of Service Reporting. These documents are available as Portable
Document Format (PDF) files on the PATROL Performance
Documentation CD. For more information on the specific Oracle and
Actuate documents, “Related Documentation” on page B-1 contains a
of the documents.

Note
This book assumes that you are familiar with your host operating syste
You should know how to perform basic actions in a window
environment, such as choosing menu commands and dragging and
dropping icons.
BMC Software, Inc., Confidential and Proprietary Information
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How This Book Is Organized

This book is organized as follows. In addition, a glossary of terms and
index appear at the end of the book.

Chapter/Appendix Description

Chapter 1 “Introducing Service Reporting” Provides an introduction to Service Reporting
and its various components.

Chapter 2 “Pre-Installation Information for Service
Reporting on Windows NT and Windows 2000”

Describes the requirements you must satisfy
and the tasks you must perform before you
install Service Reporting on Windows NT.

Chapter 3 “Installing Service Reporting on
Windows NT and Windows 2000”

Describes the procedure for installing Service
Reporting on Windows NT.

Chapter 4 “Pre-Installation Information for Service
Reporting on Sun Solaris”

Describes the requirements you must satisfy
and the tasks you must perform before you
install Service Reporting on Sun Solaris.

Chapter 5 “Installing Service Reporting on Sun
Solaris”

Describes the procedure for installing Service
Reporting on Sun Solaris Unix computers.

Chapter 6 “Configuring Service Reporting” Describes what you need to do and know to
configure Service Reporting components.

Appendix A,  “Troubleshooting” Provides troubleshooting tips and
recommendations.

Appendix B,  “Related Documentation” Describes related documentation.

Appendix C,  “Service Reporting Component List” Provides a list of Service Reporting
components.
BMC Software, Inc., Confidential and Proprietary Information
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Related Documentation
BMC Software products offer several types of documentation:

• online and printed books
• online Help
• release notes

Online and Printed Books

The books that accompany BMC Software products are available in
online format and printed format. You can view online books with
Acrobat Reader from Adobe Systems. The reader is provided at no c
as explained in “To Access Online Books.” You can also obtain
additional printed books from BMC Software, as explained in “To
Request Additional Printed Books.”

To Access Online Books

Online books are formatted as Portable Document Format (PDF) files
You can view them, print them, or copy them to your computer by usi
Acrobat Reader 3.0 or later.You can access online books from the
documentation compact disc (CD) that accompanies your product or
from the World Wide Web.

In some cases, installation of Acrobat Reader and downloading the
online books is an optional part of the product-installation process. Fo
information about downloading the free reader from the Web, go to th
Adobe Systems site athttp://www.adobe.com.

To view any online book that BMC Software offers, visit the support
page of the BMC Software Web site athttp://www.bmc.com/support.html.
Select a product to access the related documentation.
BMC Software, Inc., Confidential and Proprietary Information
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To Request Additional Printed Books

BMC Software provides a core set of printed books with your product
order. To request additional books, go to
http://www.bmc.com/support.html.

Online Help

You can access Help for a product through the product’s Help menu. 
online Help provides information about the product’s graphical user
interface (GUI) and provides instructions for completing tasks.

Release Notes

Printed release notes accompany each BMC Software product. Relea
notes provide up-to-date information such as

• updates to the installation instructions
• last-minute product information

The latest versions of the release notes are also available on the Web
http://www.bmc.com/support.
BMC Software, Inc., Confidential and Proprietary Information
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Conventions

The following conventions are used in this book:

• This book includes special elements callednotesand warnings:

Note
Notes provide additional information about the current subject.

Warning
Warnings alert you to situations that can cause problems, such as los
data, if you do not follow instructions carefully.

• In instructions,boldface type highlights information that you enter.
File names, directories, and Web addresses also appear in boldfa
type.

• The symbol=> connects items in a menu sequence. For example,
Actions => Create Test instructs you to choose the Create Test
command from the Actions menu.

• The symbol» denotes one-step instructions.
BMC Software, Inc., Confidential and Proprietary Information
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Introducing Service Reporting 1

This chapter introduces Service Reporting and includes the following
topics:

Service Reporting Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Optimizing Business-Critical Applications Through Reports . . . 1-2
Understanding the Process Flow from Data Collection

to Reporting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Understanding the Service Reporting Studio. . . . . . . . . . . . . . . . 1

Behind the Scenes: Where Is the Data? . . . . . . . . . . . . . . . . . . . . . . .
Getting Started with Service Reporting . . . . . . . . . . . . . . . . . . . . . . . 1
BMC Software, Inc., Confidential and Proprietary Information
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Service Reporting Overview
Service Reporting is a collection of tools you can use in your current
PATROL environment to gather and store data, and create reports. Th
reports you can create, based on the stored data, reflect your enterpr
Because Service Reporting integrates data collection, storage and re
creation and viewing tools, you can use the product to optimize your
business-critical applications.

Optimizing Business-Critical Applications Through Reports

Service Reporting’s report creation and viewing tools provide predefin
(Solution Reports) and user-defined (QuickReports) reports. You can
any combination of Solution Reports or QuickReports to look at
information from different points of view.

By examining different aspects of information through the reports you
choose, you can get a more thorough understanding of how applicati
in your enterprise are—or are not—functioning. Better still, you can u
the depth of information provided through the reports you choose to
make decisions on how to optimize performance.

Understanding Solution Reports

Solution Reports are predefined, prescheduled reports that provide
out-of-the-box functionality and require little or no setup. If your
responsibilities include system administration, Solution Reports are
especially helpful for performing daily tasks and planning for future
growth in the enterprise.

Solution Reports are designed to give you detailed information on
system, application, and database performance. With this information
you can keep your enterprise tuned.

Solution Reports available in this version are:

• Solution Reports for Microsoft Exchange Server
• Solution Reports for Microsoft Exchange 2000
BMC Software, Inc., Confidential and Proprietary Information
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• Solution Reports for NT Server
• Solution Reports for Lotus Domino
• Solution Reports for Oracle
• Solution Reports for Unix

Note
To view specific solution reports, you must be licensed by BMC
Software for the corresponding Knowledge Module. For example, if y
want to generate Solution Reports for Oracle, you must be licensed f
PATROL KM for Oracle to collect the data. Contact your BMC Softwa
representative for more information.

Understanding QuickReports

QuickReports are user-defined report templates that you create, sche
edit, and delete by using the “QuickReport Editor,” a Web-hosted utili
that guides you through each step. The information in your selected
QuickReport is pulled from the . The  is where collected data is
summarized for use in later reporting. For more information, see “Behi
the Scenes: Where Is the Data?” on page 1-6.

To create a report template, choose one of the available template sty
(as shown in Table 1-1), and then specify the data you want in your
reports, such as computers, applications, parameters, instances, time
spans, units of measure, titles, and so forth.

Note
You can use any parameter that any PATROL KM collects as the bas
a QuickReport.
BMC Software, Inc., Confidential and Proprietary Information
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Table 1-1 QuickReport Template Types

To List or Display Choose This Template

A user-defined number of components and
their associated events, in table format.

Event Summary Table

The measurement value of a particular
enterprise component for a specified time span
of the report along with the top or bottom n
readings for a measurement or parameter, in
table format.

Hot Spots Table

The n component values where the
user-specified threshold (above or below) was
crossed (the time span is also user-specified),
in table format.

Hot Spots Threshold Table

The n number of components with the highest
or lowest values of a parameter, in bar graph
format.

Summary Graph

A number of components and their associated
parameter values, in table format.

Summary Table

The measurement value of a set of
components representing a specific time
period (the time span is user-specified) in line
graph format.

Trend Graph

Multiple measurements for multiple
components representing a specific time
period (the time span is user-specified) in line
graph format.

Trend Graph
(Multi-Parameter)

The measurement value of a set of
components representing a specific time
period, in table format (the time span is
user-specified).

Trend Table

Multiple measurements for multiple
components representing a specific time
period (the time span is user-specified) in table
format.

Trend Table
(Multi-Parameter)

Several different KM parameters for the same
node/instance in order to get the detail
information about a specific node/instance.
The report produces several (usually four) line
graphs on the same page. Each line graph
shows each parameter during the specific time
span.

Multi-Quadrant Trend Graph
BMC Software, Inc., Confidential and Proprietary Information
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Note
For more details on QuickReport template types, see the online help.

Understanding the Service Reporting Studio

The Service Reporting Studio is the report customizing component of
Service Reporting. Using the Actuate documentation along with the
Service Reporting DataStore Schema, you can use the Studio to design
your own reports.

Note
Contact your sales representative for help implementing the customiz
solutions that the Reporting Studio provides. Your sales representativ
can tell you what support services your contract provides, including o
professional services organization.

Warning
BMC Software distributes the Service Reporting Studio on the Servic
Reporting product CDs as the customizing component. This customiz
environment is licensedonly through the purchase of PATROL for
Service Level Management.
BMC Software, Inc., Confidential and Proprietary Information
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Behind the Scenes: Where Is the Data?
The primary source of data for Service Reporting is information that
PATROL KMs and their associated agents collect. The collected data
represents the current state of system resources you have chosen to
manage and monitor.

The collected data is in the DataStore, which serves as a central
repository. Once information is in the DataStore, it is ready to be used
the basis for one or multiple reports.

Understanding the Process Flow from Data Collection to
Reporting

There are two parts to Service Reporting

• Configuring and collecting data
• Selecting the data you want to see and viewing, storing, and

manipulating the resulting reports

Configuring and Collecting Data

You can configure and collect data from any computer where a PATR
Agent is already installed. Basically, the following occurs (see Figure
1-1):

• Data configuration—the  Console lets you configure retrievers,
filters, and collection schedules.

• Data collection—an installed retriever collects data from agents an
sends it to a data aggregator.

• Data processing—a data aggregator sends data from multiple
retrievers to the DataStore.

Note
For more details on data collection and summarization, see theDataStore
Administrator Guide.
BMC Software, Inc., Confidential and Proprietary Information
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Figure 1-1 Collecting and Configuring Data

Selecting Data and Viewing Completed Reports

You can create reports (QuickReports) based on any parameter data
stored in the DataStore, or view predefined parameters on Solution
Reports. Once a graph or report is created, you can publish it to the W
Basically, the following occurs (see Figure 1-2).

• Report creation—you choose a report template through the
QuickReport Editor, or choose a predefined, prescheduled Solutio
Report from the Web Desktop

• Report viewing—you view the report you selected through the We
Desktop or IE 5.0 or Netscape 4.5 or later

• Report administration—you store reports in the Report
Encyclopedia for later administration through the Administrator
Desktop

DataStore

Data
Aggregator

DataStore Console

PATROL Agent

Retrievers Retrievers

Data Collection and Configuration

PATROL Agent

Data Collection

Data Processing

Data Configuration
BMC Software, Inc., Confidential and Proprietary Information
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Figure 1-2 Selecting Data and Viewing Completed Reports

Note
For more information about the different  components, data collection
processing, and storage, see the DataStore Administrator Guide.

For more information about report configuration, creation, storage, an
manipulation, see theReporting User Guide.

For more information about customizing your reports with the Reporti
Studio, see theService Reporting DataStore Schema. This customizing
environment is licensedonly through the purchase of PATROL for
Service Level Management.

Administrator Desktop Web Desktop

Report
Web Server

Report Server

Report
Encyclopedia

Report Creation and Viewing

 Consoles

QuickReport
Editor

QuickReport

Report
creation and viewing

Report
administration

Note that the Administrator Desktop, Web Desktop, and Reporting Portal
can be installed on one machine (preferred) or multiples.

Reporting Portal

QuickReport

Solution
Report

Solution
Report
BMC Software, Inc., Confidential and Proprietary Information
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Service Reporting’s Overall Architecture

In Service Reporting, the product architecture combines data collectio
and report creation and manipulation as shown in Figure 1-3.

Figure 1-3 Service Reporting Data Collection and Reporting Architecture

Administrator Desktop Web Desktop

Report
Web Server

Report Server

Report
Encyclopedia

Report Creation and  Viewing

 Consoles

QuickReport
Editor

Solution
Report

QuickReport

Report
creation and viewing

Report
administration

DataStore

Data
Aggregator

DataStore Console

Retriever Retriever

Data Collection and Configuration

PATROL Agent

Data Collection

Data Processing

Data Configuration

PATROL Agent

Note that the Administrator Desktop, Web Desktop, and Reporting
Portal can be installed on one machine (preferred) or two.

Reporting Portal

Solution
Report

QuickReport
BMC Software, Inc., Confidential and Proprietary Information
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Recommended Installation Configurations

BMC Software has tested and recommends the following configuratio
Select the configuration that best describes your environment.

• Chapter 3: Installing Service Reporting on Windows NT and
Windows 2000
Describes how to install all components (data collection, reporting
and database) on a single Windows NT or Windows 2000 comput
or multiple Windows NT or Windows 2000 computers.

• Chapter 5: Installing Service Reporting on Sun Solaris Computers
Describes how to install Service Reporting components on a sing
Sun Solaris computer or multiple Sun Solaris computers.

Note
When installing Service Reporting in a Sun Solaris environment you s
need a Windows NT or Windows 2000 computer for the following
components:
~ DataStore Console
~ Administrator Desktop
~ Reporting Studio
BMC Software, Inc., Confidential and Proprietary Information
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Getting Started with Service Reporting
Now that you have a brief introduction, to run Service Reporting as
quickly as possible, BMC Software recommends that you do the
following:

First, turn to the Glossary at the end of this book. Even if you’re a current
PATROL user, you’ll find new terminology in Service Reporting. Use the
Glossary to get familiar with the new terms you’ll see in this book.

Second, read the preinstallation for Windows NT, Windows 2000, and Unix
information carefully. This step is critical; you must ensure that your
environment and target computers meet minimum standards for the setup
option you want, before you begin installing the product. For more
preinstallation details, turn to Chapter 2, “Pre-Installation Information for Service
Reporting on Windows NT and Windows 2000” or Chapter 4, “Pre-Installation
Information for Service Reporting on Sun Solaris.”

Third, follow the installation procedures for the installation option setup you
choose. For more installation details, turn to Chapter 3, “Installing Service
Reporting on Windows NT and Windows 2000” or Chapter 5, “Installing Service
Reporting on Sun Solaris.”

Fourth, read and follow the configuration procedures. Once you complete this
step, you’re ready to begin generating reports. For more configuration details,
turn to Chapter 6, “Configuring Service Reporting”.

Finally, BMC Software recommends that you read “Related Documentation” on
page B-1, and use the Reporting Online Help as you work with Service
Reporting.
BMC Software, Inc., Confidential and Proprietary Information
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Pre-Installation Information for
Service Reporting on Windows NT
and Windows 2000 2

This chapter describes pre-installation recommendations and tasks fo
Service Reporting on Windows NT and Windows 2000 and contains t
following topics:

Pre-installation Recommendations and Tasks  . . . . . . . . . . . . . . . . . .
Pre-installation Recommendations  . . . . . . . . . . . . . . . . . . . . . . . 2
Pre-installation Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Pre-installation Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
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Pre-installation Recommendations and Tasks
This section describes pre-installation recommendations and tasks.

Pre-installation Recommendations

Service Reporting contains many different components. To successfu
install them, perform the following tasks:

• Log on to the local computer using the user account created for
PATROL. If one does not exist, add one using theStart Menu =>
Programs => Administrative Tools => User Manager (for
Domains).You need to do this from an administrator’s account on t
local computer.

• Make sure Oracle isnot installed on the computer where DataStore
will be installed. If the Report Server computer already has an Ora
8.1.7 or newer client installed, do not install the DataStore Client
there.

• Create a disk image of your computer drives once you satisfy the
software pre-requisites before installing Service Reporting. If you
have problems, you can quickly and easily restore the original ima

• Make sure PATROL is installed. Service Reporting assumes
familiarity with PATROL. As a standalone product, Service
Reporting can operate without PATROL. However, if you want to
collect data you must have PATROL Agents installed.

• In addition to the PATROL home directory set up when you install
PATROL, BMC Software recommends setting up a separate
directory to install Reporting and database components. Because
PATROL dependencies, you must install the Aggregator and
retrievers in the PATROL home directory.

• Make sure you are licensed for the Knowledge Modules associate
with the Solution Reports you wish to install and use.

• Read the Readme First System Setup Notes found in the kit with
your CD. It details the software you need to install and upgrade
before installing Service Reporting components.
BMC Software, Inc., Confidential and Proprietary Information
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Pre-installation Requirements

Use the following table as a tool for preparing your computer to instal
Service Reporting.

Table 2-1 Pre-installation Requirements Check List

Check Here When You Complete the Following Task

Read the Service Reporting Release Notes found
in the kit with your CD.

Stop system services before installing Service
Reporting (see page 2-12).

If you are migrating from an earlier version of
Service Reporting, migrate your QuickReport Editor
reports and Solution reports. See the Service
Reporting Release Notes for report migration
information on Windows and Unix.

Verify the necessary hardware and software (see
page 2-4) needed to successfully install and run
Service Reporting.

Determine where you want to install Service
Reporting components.

Validate your PATROL environment (see page
2-10).

Set up a separate PATROL directory for the
Reporting and Database Components.

Upgrade system DLLs (see 2-12). If you are
running a Windows 2000 machine your system
DLLs are already at the version 6 level.

Verify that the Windows NT and Windows 2000
challenge response security mechanism is turned
off in the IIS Security Configuration (see page
2-13).
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Hardware and Software Requirements

Use the following tables to verify that you have the correct hardware a
software levels to optimize the performance of Service Reporting.

Hardware Requirements

The following tables outline the various hardware requirements for th
different components of Service Reporting. Table 2-2 shows the
minimum and recommended hardware requirements for running
DataStore.

Table 2-3 outlines the hardware requirements for running the Report
Server on a different computer than the computer running DataStore.
you are running them on the same machine, take that into account w
calculating your system hardware requirements.

Table 2-4 outlines the hardware requirements for running all Service
Reporting components on one computer.

Table 2-2 DataStore Hardware Requirements

Component Minimum Recommended

CPU 350 MHz Intel-compatible 500 MHz Intel-compatible

Memory 512 MB RAM 1024 MB RAM

Storage 10 GB Disks 20 GB Disks

Table 2-3 Reporting Hardware Requirements

Component Minimum Recommended

CPU 350 MHz Intel-compatible 500 MHz Intel-compatible

Memory 1024 MB RAM 2048 MB RAM

Storage 4 GB Disks 8 GB Disks
BMC Software, Inc., Confidential and Proprietary Information
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The data aggregator must be running on a computer that has at least
MB RAM with a network connection to the DataStore.

Software Requirements

Table 2-5 outlines the software requirements for the different
components of Service Reporting.

Browser Requirements

Service Reporting includes a QuickReport Editor that you can use to
create report templates based on several generic report types. The
QuickReport Editor requires a Web browser, Internet Explorer, or
Netscape Communicator.

Table 2-4 Hardware Requirements for Running All Service Reporting
Components on One Computer

Component Minimum Recommended

CPU 400 MHZ Intel-compatible Two 500 MHz Intel-compatible

Memory 1024 MB RAM 2048 MB RAM

Storage 20 GB Disks 40 GB Disks

Table 2-5 Service Reporting Software Requirements

Component Software Version

DataStore Microsoft Windows NT Server
Sun Sparc Solaris

4.0, Service Pack 4 or later
2.7 or later

Data Aggregator &
Retrievers

PATROL® Console 3.4.00 or later

PATROL® Agent 3.4.00 or later

Reporting Components

Microsoft IIS Web Server 4.0 (NT), 5.0 (Windows 2000)

Microsoft Internet Explorer 5.0 or later

Netscape Browser 4.5 or later (excluding 6.x)

Sun JRE Plug-In 1.3
BMC Software, Inc., Confidential and Proprietary Information
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Both browsers require the use of the Sun Java 1.3 Plug-in. For more
information, see “Java Plug-in Download Issue with Internet Explorer
on page 2-6 and “Java Plug-in Download Issue with Netscape” on pa
2-6.

You can use Microsoft Internet Explorer, version 5.0 or Netscape
Communicator version 4.5 or later. Although you can use the
QuickReport Editor with earlier versions of Internet Explorer, BMC
Software does not recommend or support this.

Note
Service Reporting version 1.2.00 does not support Netscape 6.x.

To access the QuickReport Editor, use the following URL, where
<server-name> is the name of the computer where both the Report Ser
and the Web Server are installed:

http:// server-name/acweb/server-name

Note
You must install Microsoft IIS on the computer where you install the
Report Server.

Java Plug-in Download Issue with Internet Explorer

If the Java Plug-in fails to download and install on Internet Explorer, tu
off execute privileges for the directory in which you are putting the Ja
Plug-in Software executable.

Java Plug-in Download Issue with Netscape

You can use the QuickReport Editor with Netscape Communicator
version 4.5 or later, as long as you install the Sun JRE Plug-in, versio
1.3, available on the web site specified on the Service Reporting CD.

Note
Service Reporting version 1.2.00 does not support Netscape 6.x.
BMC Software, Inc., Confidential and Proprietary Information
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Service Reporting Components in a Windows NT and Windows 2000 Environment

The following table recommends locations for installing the various
Service Reporting components. The table makes the following
assumptions:

• The PATROL Console is already installed on the computer identifi
in the table as the Windows NT and Windows 2000 Console.

• PATROL Agents are already installed on all of the Windows NT an
Windows 2000 computers (Console, Server, Managed).

• You will install retrievers and Aggregators on the same computers
and same directory with PATROL Agents.

• You have a separate PATROL directory for installing the reporting
and database components.

• If the Windows NT and Windows 2000 Server is managing itself, i
will have a retriever on it.

Note
The QuickReport Editor is not an installation option. It is automatically
installed when you install other Reporting components.
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Table 2-6 Option 1 - Installing Service Reporting Components in an Windows NT and
Windows 2000 Environment

On the Destination Computer

To Install the
following Service
Reporting
Component

Use the
Following
Installation
Option

Windows
NT and
Windows
2000
Console

Windows
NT and
Windows
2000
Server

Managed
Computers
(Window
NT and
Windows
2000 or
Unix)

Client
Computer

DataStore Console

Install Data
Collection
Components

✔ ✔

Aggregator Console KM ✔

Retrievers Console KM ✔

Retrievers ✔

Data Aggregator ✔ (Windows
NT and
Windows
2000 only)

Administrator Desktop

Install
Reporting
Components

✔ ✔

Report Server for
Windows NT

✔

Solution Reports ✔

Web Agent ✔

Reporting Studio ✔ ✔ ✔ (Windows
NT and
Windows
2000 only)

✔

Reporting Portal ✔

Publisher/Zone Index ✔

JRE 1.3.1 for the
Reporting Portal

✔

DataStore Server and
DataStore Client

Install
Database
Components

✔
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Pre-installation Tasks

You must perform the following tasks before you install Service
Reporting components in a Windows NT and Windows 2000
environment.

• Validate your PATROL Environment (see “Validating Your PATROL
Environment” on page 2-10)

• Upgrade System DLLs (see “Upgrading System DLLs to Version 
on page 2-12)

• Disable Windows NT Challenge/Response (“Disabling Windows N
Challenge/Response Authentication” on page 2-13)
BMC Software, Inc., Confidential and Proprietary Information
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Validating Your PATROL Environment

You need access to a PATROL Console to:

• Discover PATROL Agents
• Configure, start, and stop retrievers and data aggregators
• Troubleshooting purposes

To Validate Your PATROL Environment

Verify that you have PATROL Agents and accounts on the computers
where you want to install the data aggregators and retrievers for
DataStore. You can use the PATROL Console to add the target hosts
the PATROLMainMap view of the Console.

Note
You must install data collection components (aggregators and retrieve
in the PATROL home directory, that is, the directory you installed
PATROL into (for exampleD:\PATROL3-4).

Step 1 From the PATROL Console, chooseHosts => Add.

Note
You can use a Developer Console or an Operator Console.

Step 2 You will be prompted for the appropriate connection and user ID
information. Use

• Operator
• TCP
• User-specified name and password

If PATROL is properly installed, you will have the appropriate PATROL
account and permissions.

Step 3 If you don’t have the proper permissions, you will be prompted to log o
and then log on again. You should then have the accounts and
BMC Software, Inc., Confidential and Proprietary Information
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permissions you need accessed from the Windows NT User Manage
Domains. The accounts and permissions are:

• Log on as a Service (required for Actuate Report Server also)
• Act as part of OS
• Increase quotas
• Profile system performance
• Replace a process level token
• Log on locally
• Debug programs

Note
BMC Software recommends installing the DataStore Console on or n
the same computer where the PATROL Console is installed.
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Upgrading System DLLs to Version 6

Note
If you are running a Windows 2000 machine your system DLLs are
already at the version 6 level.

Service Reporting requires that you run the scriptupgradeDLL.bat to
upgrade system DLLs to version 6 before you install the product. The
script is located on the Service Reporting – Microsoft Windows NT
Server CD in the DLLUpgrade directory.

The utility attempts to upgrade the following DLLs in
%SYSTEMROOT%\system32\:

• msvcirt.dll
• msvcrt.dll
• mfc42.dll

The utility checks the version of the system DLLs. The DLLs from the
utility are only copied to the system if the DLL in the utility is a newer
version than that of the DLL on the system.

Original DLLs are copied tofilename.dll.old in their original location.
You can rename these files to their original name to restore the mach
to its previous state. Youmustrestart the system after restoring these
files.
BMC Software, Inc., Confidential and Proprietary Information
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Disabling Windows NT Challenge/Response Authentication

This section includes information on checking and changing the
Windows NT Challenge/Response settings on Internet Information
Server 4.0 (IIS4).

Disabling Windows NT Challenge/Response authentication is a Web
Server requirement before using the Service Reporting Report Serve
component. Otherwise, access to the Report Server over the Web
becomes a problem since the Web Desktop does not start.

Disabling Windows NT Challenge/Response Authentication in IIS4

To disable Windows NT Challenge/Response authentication on IIS4,
complete the following steps from the Internet Service Manager of the
Microsoft Management Console:

Step 1 ChooseStart => Programs => Windows NT 4.0 Option Pack=> Microsoft
Internet Information Server  => Internet Service Manager.

Step 2 Right-click theDefault Web Siteassociated with the server where you
intend to install the Service Reporting Report Server, and click
Properties.

Step 3 When the Default Web Site Properties dialog box is displayed, click th
Directory Security tab and clickEdit  in the Anonymous Access and
Authentication Control section.

Step 4 On the Authentication Methods dialog box, make sure thatWindows NT
Challenge/Response is not selected. If theWindows NT
Challenge/Response check box contains a check mark, click the check
mark to remove it. Then, clickOK .

Disabling Windows NT Challenge/Response Authentication in IIS5

To disable Windows NT Challenge/Response authentication on IIS5,
complete the following steps from the Internet Service Manager of the
Microsoft Management Console:
BMC Software, Inc., Confidential and Proprietary Information
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Step 1 ChooseStart => Programs => Administrative Tools => Internet Services
Manager => Internet Service Manager.

Step 2 Click the node name to expand it.

Step 3 Right-click on the Default Web Site and go to Properties Page.

Step 4 Click the Directory Security tab.

Step 5 Click Edit under the Anonymous access and authentication control.

Step 6 Ensure that Anonymous access and basic authentication are the only
selections enabled.
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Installing Service Reporting on
Windows NT and Windows 2000 3

This chapter describes the procedure for installing Service Reporting
Windows NT and Windows 2000 and contains the following topics:

Installation Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Uninstalling Service Reporting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
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Introduction
Since every production environment is unique, it is impossible to
describe every possible configuration. You are the most knowledgeab
person when it comes to where you want your consoles (DataStore a
PATROL), Report Server, DataStore (database and client), and Web
client components installed to optimize productivity and response tim
This chapter provides guidelines and recommendations for configurin
your system in a Windows NT and Windows 2000 environment.

The installation program is wizard-driven, making it easy for you to
install all or some components on console and agent computers. You
also run the installation program non-interactively (silently). For
additional information see Step 8 on page 3-28.

Installation Overview

Note
Although it is a stand-alone product, Service Reporting installation is 
subset of the overall PATROL installation. However, Service Reportin
requires that you install PATROL. To do so, consult the appropriate
Getting Started book for that component.

The chapter is organized in three sections

• Installation
• Installation verification
• Uninstalling
BMC Software, Inc., Confidential and Proprietary Information
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You use the installation program to install Service Reporting to the
Windows NT and Windows 2000 computer you are currently logged
onto, or as a network installation on computers that are members of y
local domain. The installation program lets you install Service Report
components on one Windows NT computer or onto multiple compute
at one time, including your other computer.

Note
If you are migrating from an earlier version of Service Reporting, you
must unschedule existing Solution Reports, install the product, run the
utilities that migrate the Solution Reports from version 1.1.20 to 1.2.0
reschedule the reports. See the Service Reporting Release Notes for
description of the migration utilities.
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Installation
This section describes general installation recommendations and
installation procedures.

General Installation Recommendations

• BMC Software recommends installing the PATROL® Console
nearby but not on the computer where the DataStore and Report
Server will be installed. This reduces resource consumption issue

• Install DataStore and Report Server on a computer that is running
clean Windows NT and Windows 2000 4.0 Server with Service Pa
4 or later.

• Verify that the DNS is properly configured in the domain you inten
to use. If you are using host names instead, make sure the host na
on the Aggregator nodes are the same as the names on the Data
Console. See theDataStore Administrator Guide for more
information.

• Login as a local administrator account. A domain administrator
account does not have sufficient permissions.

• Use the CD to install all Service Reporting components locally wh
possible.

• Use remote installation for retrievers and aggregators when install
to multiple hosts.

• In a high capacity production environment, BMC Software
recommends installing the Report Server and the DataStore data
on separate servers.

• To optimize performance and minimize the installation time
required, BMC Software recommends installing everything,except
retrievers, locally when possible.

Installing Service Reporting

The Service Reporting installation program for Windows NT and
Windows 2000 divides the installation into three sections. You can inst
the components in any order you choose. Each section installs speci
components of Service Reporting.
BMC Software, Inc., Confidential and Proprietary Information
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• Install Data Collection and DataBase Components
Perform collection, manipulation, and monitoring of data.
Components include: Retrievers Console KM, Aggregator Consol
KM, DataStore Console, Retrievers, and Data Aggregators.

Installs the DataStore client only or the DataStore Server and
DataStore Client. The DataStore client enables communication
between the Report Server and the DataStore.

• Install Reporting Components
Customizes report templates and view pre-defined reports.
Components include: Reporting Clients, Web Agents, the Report
Server, QuickReports, and pre-defined Solution Reports.
BMC Software, Inc., Confidential and Proprietary Information
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Installing Data Collection and Database Components

This task installs the Service Reporting components that perform dat
collection, manipulation, and monitoring. The components include
Retrievers and Aggregator Console KMs and the DataStore Console.
a list of data collection components, see the “Windows NT and Windo
2000 Installation Component List” on page C-2.

This task also installs the database components (“DataStore Server a
DataStore Client”) on the Windows NT and Windows 2000 Server
computer on which the Report Server is installed. For more informatio
on the database components, see the “Windows NT and Windows 20
Installation Component List” on page C-2.

Tip
As you answer the installation prompts, keep in mind that the installati
pages are the same whether your are installing the application locally
whether you want to export the installation to another machine and ins
it there. At the end of the installation prompts, you can zip up the
installation and export it to another machine for a remote or “silent”
install.

To Install Data Collection Components

Step 1 Insert the Service Reporting DataStore CD into the CD-ROM drive an
double-clicksetup.exe to run the installation utility to display the
Welcome to the Installation Utility page.

1.A If the installation program does not start automatically, use on
of the following methods to open the PATROL NT Installation
Launcher dialog box:

• From Windows Explorer, select your CD-ROM drive, and then
double-clicksetup.exeto start the installation program.

Or
BMC Software, Inc., Confidential and Proprietary Information
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• From the Start menu, chooseRun, and enter the following
command: D:\setup.exe if D:\ is your CD-ROM drive.The
PATROL NT Install Launcher appears.

1.B If the PATROL Windows NT Install Launcher starts
automatically, click Install Service Reporting.

Step 2 On the Welcome to the Installation Utility page, click Next to display the
Review License Agreement page.

Figure 3-1 Welcome to the Installation Utility Page

Step 3 On the Review License Agreement page, clickAccept to continue with
the installation and clickNext to display the Select Type of Installation
page.
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Installing Service Reporting on Windows NT and Windows 2000 3-7



,

ct.

his
Figure 3-2 Select Type of Installation Page

Step 4 On the Select Type of Installation page, clickTypical or Custom and then
Next to display the Specify Installation Directory page.

Note
TheTypical install path offers a quick installation path with fewer panels
and uses default specifications. TheCustom path offers you greater
control over your installation configuration. Choose theTypical path if
you are installing the product for the first time, or are new to the produ
Choose theCustom installation path if you are an advanced user and
want to customize the installation configuration. For the purposes of t
example, theCustom installation path is described.
BMC Software, Inc., Confidential and Proprietary Information
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Figure 3-3 Specify Installation Directory Page

Step 5 On the Specify Installation Directory page, specify the location where
you want to install Service Reporting in theBMC Products Installation
Directory field. The default directory isC:\Program Files\BMC Software.
When finished, clickNext to open the Select Products and Component
to Install page.
BMC Software, Inc., Confidential and Proprietary Information
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Figure 3-4 Select Products and Components to Install Page

Step 6 On the Select Products and Components to Install Page, expand all t
and select all boxes. If you want to install retrievers remotely, BMC
Software recommends a separate pass using Export (see “To Install 
Aggregator and Retrievers” on page 3-22). ClickNext to display the
Service Reporting Family Product Installation Directory page.

Note
For existing users this is the point at which you migrate the DataStore
database. To do so, select Migrate DataStore Server/Instance to Rele
1.2.
BMC Software, Inc., Confidential and Proprietary Information

3-10 Service Reporting Getting Started



e

rs)

s.
Warning
When you are installing the Report Server and DataStore on one
computer, do not install both database component options (“DataStor
Client Only” and “DataStore Server and DataStore Client”). Doing so
results in problems using the DataStore Server. Select only the
“DataStore Server and DataStore Client” option.

Note
You must install data collection components (aggregators and retrieve
in the PATROL home directory, that is, the directory you installed
PATROL into (for exampleD:\PATROL3-4). BMC Software recommends
installing reporting and database components into separate directorie
This makes it easier to maintain an audit trail or uninstall these
components.
BMC Software, Inc., Confidential and Proprietary Information
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Figure 3-5 Service Reporting Family Product Installation Directory Page

Step 7 On the Service Reporting Family Product Installation Directory page,
specify the PATROL Product Installation Directory.

Note
You must install these components in the PATROL home directory, th
is, the directory you installed PATROL into (for example
D:\PATROL3-4). If you have installed PATROL 3.4.11 you must append
"-4" to Patrol3. If you have installed PATROL 3.5, you can use the
default directory Patrol3.
BMC Software, Inc., Confidential and Proprietary Information
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Step 8 Specify the PATROL Agent login name and password. ClickNext to
display the Review Selections and Install page.

Warning
If the user who will own the Report Server services is defined as a
domain user, rather than a machine-local user, then you must prefix t
userid with <domain_name> and a backslash, for example,
BMC.COM\username.

Figure 3-6 Review Selections and Install Page

Table 3-1 PATROL Default Account Information

Field Description

Account Name Enter the account name you are using to install
Service Reporting.

Password Enter the password you are using to install Service
Reporting.
BMC Software, Inc., Confidential and Proprietary Information
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Step 9 On the Review Selections and Install page, review your selections an
click Install .

Step 10 Watch the Installation Status page to verify that the Service Reporting
installation process completes successfully. When the installation is
complete, clickNext.

Step 11 On the SUCCESS page, clickView Log File to review the installation log
file. When you are done, clickFinish. The DataStore components are
now installed on your system.
BMC Software, Inc., Confidential and Proprietary Information
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Installing Reporting Components on the Windows NT and Windows
2000 Server

This task installs the reporting components of Service Reporting.
Reporting components let you create and view custom reports from
report templates using the QuickReport Editor or pre-defined Solution
reports. Some of the components included in this section are
QuickReports, Solution Reports, and Report Server. For more
information on reporting components, see the “Windows NT and
Windows 2000 Installation Component List” on page C-2.

To Install Reporting Components

Step 1 Insert the Service Reporting CD into the CD-ROM drive and
double-clicksetup.exe to run the installation utility to display the
Welcome to the Installation Utility page.

1.A If the installation program does not start automatically, use on
of the following methods to open the PATROL NT Installation
Launcher dialog box:

• From Windows Explorer, select your CD-ROM drive, and then
double-clicksetup.exeto start the installation program.

Or

• From the Start menu, chooseRun, and enter the following
command: D:\setup.exe whereD:\ is your CD-ROM drive.The
PATROL NT Install Launcher appears.

1.B If the PATROL Windows NT Install Launcher starts
automatically, click Install Service Reporting.

Step 2 On the Welcome to the Installation Utility page click Next to display the
Review License Agreement page.
BMC Software, Inc., Confidential and Proprietary Information
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Figure 3-7 Welcome to the Installation Utility Page

Step 3 On the Review License Agreement page, clickAccept to continue with
the installation and clickNext to display the Select Type of Installation
page.
BMC Software, Inc., Confidential and Proprietary Information
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Figure 3-8 Select Type of Installation Page

Step 4 On the Select Type of Installation page, clickTypical or Custom and then
Next to display the Specify Installation Directory page.

Note
TheTypical install path offers a quick installation path with fewer panels
and uses default specifications. TheCustom path offers you greater
control over your installation configuration. Choose theTypical path if
you are installing the product for the first time, or are new to the produ
Choose theCustom installation path if you are an advanced user and
want to customize the installation configuration. For the purposes of t
example, theCustom installation path is described.
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Figure 3-9 Specify Installation Directory Page

Step 5 On the Specify Installation Directory page, specify the location where
you want to install Service Reporting in theBMC Products Installation
Directory field. The default directory isC:\Program Files\BMC Software.
When finished, clickNext to open the Select Products and Component
to Install page.
BMC Software, Inc., Confidential and Proprietary Information
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Figure 3-10 Select Products and Components to Install Page

Step 6 On the Select Products and Components to Install Page, expand all t
and select all boxes. ClickNext to display the Provide Service Reporting
Directory and Account Information page.

Note
The QuickReport Editor is not an installation option. It is automatically
installed when you install other Reporting components.
BMC Software, Inc., Confidential and Proprietary Information
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To speed installation, only install the Solution Reports for the Knowled
Modules (KMs) for which your site is licensed to collect data.

Note
If you have installed some Solution Reports and at a later time wish t
install additional Solution Reports, the Report Server must be installe
and running.

Figure 3-11 Provide Service Reporting Directory and Account Information
Page

Step 7 On the Provide Service Reporting Directory and Account Information
page, specify the Service Reporting Installation Directory (if other tha
BMC Software, Inc., Confidential and Proprietary Information
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the default) and the Account Login Name and Password. ClickNext to
display the Review Selections and Install page.

Figure 3-12 Review Selections and Install Page

Step 8 On the Review Selections and Install page, review your selections an
click Install .

Step 9 Watch the Installation Status page to verify that the Service Reporting
installation process completes successfully. When the installation is
complete, clickNext.

Step 10 On the SUCCESS page, clickView Log File to review the installation log
file. When you are done, clickFinish. The Reporting components are
now installed on your system.
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Installing Data Aggregators and Retrievers

This task installs the data collection components (data aggregators a
retrievers) on managed computers where PATROL Agents have alrea
been installed. You can install retrievers on Windows NT and Window
2000 or Unix computers.

Note
BMC Software recommends installing reporting and database
components into separate directories.

Use the PATROL account for retrievers when installing the data
collection components on the agent computers (these installs are don
remotely on each agent computer).

To Install Data Aggregator and Retrievers

Step 1 Log on to the managed computer using the user-specified name and
password.

Note
You must install data collection components (aggregators and retrieve
in the PATROL home directory, that is, the directory you installed
PATROL into (for exampleD:\PATROL3-4). BMC Software recommends
setting up a directory separate to install other data collection compone
due to file and size management issues.

Step 1 Insert the Service Reporting CD into the CD-ROM drive and
double-clicksetup.exe to run the installation utility to display the
Welcome to the Installation Utility page.

1.A If the installation program does not start automatically, use on
of the following methods to open the PATROL NT Installation
Launcher dialog box:

• From Windows NT Explorer, select your CD-ROM drive, and
then double-clicksetup.exeto start the installation program.
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• From the Start menu, chooseRun, and enter the following
command: D:\setup.exe whereD:\ is your CD-ROM drive.The
PATROL NT Install Launcher appears.

1.B If the PATROL Windows NT Install Launcher starts
automatically, click Install Service Reporting.

Step 2 On the Welcome to the Installation Utility page, click Next to display the
Review License Agreement page.

Figure 3-13 Welcome to the Installation Utility Page

Step 3 On the Review License Agreement page, clickAccept to continue with
the installation and clickNext to display the Select Type of Installation
page.
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Figure 3-14 Select Type of Installation Page

Step 4 On the Select Type of Installation page, clickTypical or Custom and then
Next to display the Specify Installation Directory page.

Note
TheTypical install path offers a quick installation path with fewer panels
and uses default specifications. TheCustom path offers you greater
control over your installation configuration. Choose theTypical path if
you are installing the product for the first time, or are new to the produ
Choose theCustom installation path if you are an advanced user and
want to customize the installation configuration. For the purposes of t
example, theCustom installation path is described.
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Figure 3-15 Specify Installation Directory Page

Step 5 On the Specify Installation Directory page, specify the location where
you want to install Service Reporting in theBMC Products Installation
Directory field. The default directory isC:\Program Files\BMC Software.
When finished, clickNext to open the Select Products and Component
to Install page.
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Figure 3-16 Select Products and Components to Install Page

Step 6 On the Select Products and Components to Install Page, expand all t
and select all boxes. Select Aggregators and Retrievers. ClickNext to
display the Service Reporting Family Product Installation Directory
page.
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Figure 3-17 Service Reporting Family Product Installation Directory Page

Step 7 On the Service Reporting Family Product Installation Directory page,
specify the PATROL Product Installation Directory (if other than the
default) and the PATROL Agent login name and password. ClickNext to
display the Review Selections and Install page.

Note
You must install these components in the PATROL home directory, th
is, the directory you installed PATROL into (for example
D:\PATROL3-4).
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Figure 3-18 Review Selections and Install Page

Step 8 On the Review Selections and Install page, review your selections.
Optionally, checkExport packages to this directory, enter the full
pathname to the computer where you want the installation package
exported, and clickExport .

Step 9 Watch the Installation Status page to verify that the PATROL for
Performance installation process completes successfully. When the
installation is complete, clickNext.

Table 3-2 PATROL Default Account Information

Field Description

Account Name Enter the account name you are using to install
Service Reporting.

Password Enter the password you are using to install Service
Reporting.
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Step 10 On the SUCCESS page, clickView Log File to review the installation log
file. When you are done, clickFinish. The Perform Agent and System
Collectors are now installed on your agent computer.

Verify the destination directory to determine if it is different from the
previous two steps (for exampleD:\PATROLDATASTOREKM ). You can
modify it to be consistent with the previous two steps or use the defau

Note
It is not necessary to restart the managed computer after the retrieve
installation.

Installation Verification

There are diagnostic tests you can run as long as you have a Web Se
up and running. These tests can assist you when troubleshooting Se
Reporting installation as well as operation. Run the diagnostic tests
before calling Customer Support.

Go to the following URL,
machinename/bmcscripts/installverificationhtml/installverification.html ,
and select the diagnostic tests you want to run.

Uninstalling Service Reporting
This section describes how to uninstall Service Reporting component
from Windows NT and Windows 2000 computers.

Uninstalling Service Reporting Components

To uninstall Service Reporting components:
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Step 1 ChooseStart => Settings => Control Panel and double-click Add/Remove
Programs. The Add/Remove Programs Properties dialog box opens.

Step 2 SelectBMC Software and clickAdd/Remove. The BMC Installation
Utility opens and the Welcome to Installation Utility - Uninstall Mode i
displayed.

Step 3 On the Welcome to Installation Utility - Uninstall Mode page, clickNext
to display the Select Type of Uninstall page.

Step 4 SelectSelected Products, and clickNext to display the Specify
Installation Directory page.

Step 5 Verify the directory path, and clickNext to display the Select Products
and Components to Uninstall page.

Step 6 Select the components you wish to uninstall, and clickNext to display
the Review Selections and Uninstall page.

Step 7 Click Uninstall to display the Uninstall Status page.

Step 8 Watch the Uninstall Status page to verify that the process is complete
When it has completed, clickNext.

Step 9 On the SUCCESS! page, clickView Log File to review the installation
log file. When you are done, clickFinish to re-open the Add/Remove
Programs Properties dialog box.

Step 10 Click Cancel to close the dialog box.
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Pre-Installation Information for
Service Reporting on Sun Solaris 4

This chapter describes the pre-installation recommendations and task
for installing Service Reporting on a Sun Solaris computer, and conta
the following topics:

Pre-installation Recommendations and Tasks  . . . . . . . . . . . . . . . . . .
General Pre-installation Recommendations. . . . . . . . . . . . . . . . . 4
DataStore Pre-installation Tasks  . . . . . . . . . . . . . . . . . . . . . . . . . 4
Sun Solaris Pre-installation Tasks and Requirements . . . . . . . . . 4
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Pre-installation Recommendations and Tasks
Before you install Service Reporting make sure your environment
conforms to the pre-installation recommendations and perform the
pre-installation tasks described in the following sections:

• General Pre-installation recommendations (page 4-2
• DataStore Pre-installation tasks (page 4-6)
• DataStore Pre-installation tasks (page 4-11)

General Pre-installation Recommendations

Service Reporting contains many different components. To successfu
install them, perform the following tasks:

• Make sure PATROL is installed. Service Reporting assumes
familiarity with PATROL.

• Log on to the local computer using the user account created for
PATROL. You need to do this from an administrator’s account on th
local computer.

• Make sure Oracle isnot installed on the computer where DataStore
will be installed. If the Report Server computer already has an Ora
8.1.5 or newer client installed, do not install the DataStore Client
there.

• Create a disk image of your computer drives once you satisfy the
software pre-requisites for installing Service Reporting. If you hav
problems, you can quickly and easily restore the original image.

• Make sure you are licensed to collect data for the Knowledge
Modules associated with the Solution Reports you wish to install a
use.

• Read the Read Me First System Setup Notes found in the kit with
your CD. It details the software you need to install/upgrade before
installing Service Reporting components.

• When installing Service Reporting the first time, BMC Software
recommends setting the log level to debugging in the PATROL
Console.

• Verify the operating system, hardware and software requirements
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Validating Your PATROL Environment

You need access to a PATROL Console to:

• Discover PATROL Agents
• Configure, start, and stop retrievers and data aggregators

To Validate Your PATROL Environment

Verify that you have PATROL Agents and accounts on the computers
where you want to install the data aggregators and retrievers for
DataStore. You can use the PATROL Console to add the target hosts
the PATROLMainMap view of the Console.

Step 1 From the PATROL Console, chooseHosts => Add.

Note
You can use a developer console or an operator console.

Step 2 You will be prompted for the appropriate connection and user ID
information. Use

• Operator
• TCP
• User-specified name and password

If PATROL is properly installed, you will have the appropriate PATROL
account and permissions.
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Verifying Operating System Software Requirements

To install Oracle8i products included with this release, your Sun SPAR
Solaris system must meet the operating system requirements listed in
Table 4-1.

Operating System Verification Commands

Table 4-2 lists the Sun Solaris installation prompts and description

Table 4-1 Operating System Software Requirements

OS Requirements Requirements

Operating System Solaris 2.6, 2.7, or 2.8. If you are installing
DataStore on this system you must be running
version 2.7 or later.

Operating System Patch Use the latest kernel patch from Sun Microsystems.
Sun provides patch information at:

http://sunsolve.sun.com/

Solaris 2.6 requires at least kernel jumbo patch
revision #105181-15 for successful installation of
Release 3 (8.1.7).

Operating System
Packages

 SUNWarc, SUNWbtool, SUNWhea, SUNWlibm,
SUNWlibms, SUNWsprot, SUNWtoo

Window Manager  X-windows must be installed on the system from
where the Installer is run. Use any Sun-supported
X-windows server, for example, dtwm, twm, olwm,
that supports Motif.

Character mode installs are not supported for
Release 3 (8.1.7).

Required Executables  The following executables must be present in the
/usr/ccs/bin directory: make, ar, ld, nm.
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Table 4-2 Sun Solaris Installation Prompts

Command Description

$ uname -a To determine your current operating system
information.

$ showrev -p To determine which operating system patches
are installed.

$ pkginfo -i [package_name] To determine which operating system
packages are installed. If you enter pkginfo -i,
all installed packages are listed.

$ xclock To determine if your X-windows system is
working properly on your. If a clock is not
displayed on your screen, X-windows is not
configured correctly. See "DISPLAY" for
instructions on configuring X-windows.

$ /usr/bin/which make
$ /usr/bin/which ar
$ /usr/bin/which ld
$ /usr/bin/which nm

To determine if you are using the correct
system executables. Each command should
point to the /usr/ccs/bin directory. If not, add
/usr/ccs/bin to the beginning of the PATH
environment variable in the current shell. See
"PATH" for instructions on setting the PATH
variable.

$ ulimit -S To check current soft shell limits. Oracle8i
Release 3 (8.1.7) includes native support for
files greater than 2 GB. Check your shell to
determine whether it will impose a limit.

$ ulimit -Ha To check maximum hard limits. The file
(blocks) value should be multiplied by 512 to
obtain the maximum file size imposed by the
shell. A value of unlimited is the operating
system default and is the maximum value of 1
TB.
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DataStore Pre-installation Tasks

There are several task associated with installing Oracle on Sun Solar

Note
For the Solaris installation you should be in the Korn shell.

• Verify that Netscape is in your current path.
• Make sure your LD_LIBRARY_PATH includes /usr/lib and

/usr/openwin/lib for Netscape to come up.
• Set your DISPLAY environment variables.
• Create a separate User and Group to administer DataStore (see

“Creating a Separate User and Group to Install the DataStore” on
page 4-7).

• Tune kernel parameters (see “Tuning Kernel Parameters on Sun
Solaris” on page 4-8).

• Apply the required Solaris patches (see “Applying Sun Solaris
Patches to Run Service Reporting Aggregators” on page 4-12).

• Validate your PATROL environment (see “Validating Your PATROL
Environment” on page 4-3).
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Creating a Separate User and Group to Install the DataStore

BMC Software recommends creating a separate user ID and group to
install and administer the DataStore Server. You can use existing use
and groups, but do not use theroot user.

Note
The user ID for the installation must useoradba as the group name.

The following steps assume you are adding a new group and user for
installation and administration.

Step 1 Use the existingoradba group or create a new group (as root user) call
oradba to put the DataStore Unix user in for administration and
installation.

To create a new group calledoradba, use thegroupadd oradba command.

On Solaris, you can use the Solaris admininstration toolAdding new
groups.

Step 2 Add the user ID that you intend to use for administering the DataStor
Server tooradba. Use the Solaris administration tool to add the user ID
to the appropriate group or as root edit/etc/group by adding user to
oradba group

If you created a new user for the DataStore, login as that user and use
newgrp oradba command to be an active member of theoradba
group.
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Tuning Kernel Parameters on Sun Solaris

You must be running Solaris 7 (Sun OS 5.7) or Solaris 8 (Sun OS 5.8
install Service Reporting version 1.2.00. Maximum tablespace size is
GB for Oracle 8.1.5 and Oracle 8.1.7.

There are a number of kernel parameters that must be a minimum siz
order for the DataStore to install and run properly on Sun Solaris. Pri
to installing DataStore, you need to validate the kernel parameters.

Note
For retrievers, you need only the Sun Solaris kernel tuning parameter
kobj_map_space_len for Sun Solaris version 2.6.

Step 1 Issue thesysdef command to get a listing of the tunable kernel
parameters. The important information is usually at the end of the list
under IPC Messages, IPC Semaphores, and IPC Shared Memory.

Step 2 Compare the values returned when you run thesysdef command with the
following table of similar information:

* IPC Messages

 65535  max message size (MSGMAX)

 65535  max bytes on queue (MSGMNB)

   256  message queue identifiers (MSGMNI)

512  system message headers (MSGTQL)

** IPC Semaphores*

  1024  semaphore identifiers (SEMMNI)

  2048  semaphores in system (SEMMNS)

  2048  undo structures in system (SEMMNU)
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   100  max semaphores per id (SEMMSL)

   100  max operations per semop call (SEMOPM)

    30  max undo entries per process (SEMUME)

 32767  semaphore maximum value (SEMVMX)

 16384  adjust on exit max value (SEMAEM)

* IPC Shared Memory

268435456      max shared memory segment size
(SHMMAX)

   100  min shared memory segment size (SHMMIN)

   300  shared memory identifiers (SHMMNI)

   100  max attached shm segments per process
(SHMSEG)

Note
The sample output comes from a machine that has already had its ke
tuned for the DataStore installation.

Step 3 Do one of the following:

• If the numbers returned in Step 1 are equal to or larger than in
Step 2, you can begin the DataStore install. For example, if th
value returned by thesysdef command formsg map (MSGMAP)
is 258 or larger, you can begin the DataStore install.

• If the numbers returned in Step 1 are smaller than those in St
2, you need to tune the kernel parameters. For example, if the
value returned by thesysdef command formsg map (MSGMAP)
is smaller than 258, you must do one of the following:
BMC Software, Inc., Confidential and Proprietary Information

4-9 Service Reporting Getting Started



ts,
— Insert the following recommended values in the/etc/system
file on the Solaris computer. If a particular line contains an
entry already, replace it with the value BMC Software
recommends. Typically, if you are using the Solaris defaul
there are no entries for these values.

forceload: sys/shmsys

forceload: sys/semsys

forceload: sys/msgsys

set kobj_map_space_len=2097152

set shmsys:shminfo_shmmax=268435456

set shmsys:shminfo_shmmin=100

set shmsys:shminfo_shmseg=100

set semsys:seminfo_semmsl=100

set semsys:seminfo_semmni=300

set semsys:seminfo_semume=30

set semsys:seminfo_semopm=100

set msgsys:msginfo_msgmax = 65535

set msgsys:msginfo_msgmnb = 65535

set msgsys:msginfo_msgmap = 258

set msgsys:msginfo_msgmni = 256

set msgsys:msginfo_msgssz = 16

set msgsys:msginfo_msgtql = 512
BMC Software, Inc., Confidential and Proprietary Information
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set msgsys:msginfo_msgseg = 32767

set shmsys:shminfo_shmmni = 300

set semsys:seminfo_semmni = 1024

set semsys:seminfo_semmap = 1026

set semsys:seminfo_semmns = 2048

set semsys:seminfo_semmnu = 2048

— If you edit the /etc/system file, you must restart the Solaris
computer to reset the kernel parameters to the new values
You do not have to rebuild your kernel. After the restart, yo
should install DataStore according to the installation
instructions.

— Optionally, you can rerunsysdef to verify that the new
parameters are set.

Sun Solaris Pre-installation Tasks and Requirements

The following sections detail the pre-installation tasks and pre-requisi
for installing Service Reporting in a Sun Solaris environment:

• Apply Sun Solaris patches (see “Applying Sun Solaris Patches to
Run Service Reporting Aggregators” on page 4-12)

• Verify hardware and software levels (see “Verify Hardware and
Software Requirements” on page 4-14)

• Evaluate installation location recommendations (see
“Recommendations for Sun Solaris Installation Locations” on pag
4-16)
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Applying Sun Solaris Patches to Run Service Reporting Aggregators

Note
For the latest information on which Solaris version numbers require
which patches, go to the Sun Microsystems Web site at
http://www.sun.com/developers/tools/solaris.

You must install the appropriate Solaris patch to run the Aggregator. T
patches areNOT required for Solaris Retrievers or the DataStore. The
following table lists the required patch IDs by the Solaris version numb
and gives a brief description of the patch and any special circumstanc
associated with them.

Note
While it is possible to install the Aggregator on Solaris 2.5 under
PATROL 3.2, the Aggregator isnot supported on Solaris 2.5. Itis
supported on Solaris 2.6, 7, and 8.
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Step 1 Enter the following command:

ftp sunsolve1.sun.com

Step 2 Log on asanonymous/email.

Step 3 Change directory (cd) to:

pub/patches

Table 4-3 Solaris Patch IDs Required to Run Service Reporting Aggregators

Solaris
Version Patch ID Description

2.6

105490-07 required Linker Patch

105568-16 required Libthread Patch. Apply this patch last.

105210-27 required LibC Patch

106040-13 required X Input & Output Method Patch

105633-36 required OpenWindows 3.6: Xsun Patch. This patch is
required in Asian locales.

106409-01 required Fixes the Chinese TrueType fonts. This patch is
required to display traditional Chinese characters
in Swing applications.

108091-03 required SunOS 5.6: ssJDK1.2.1_03 fails with fatal error
in ISO8859-01 Locales. This patch (108091-03 or
newer) is required for any locale which uses
ISO8859-1 or ISO8859-15 character encoding.

105181-19 recommended Kernel Update (socket close/hang).

105669-10 recommended CDE 1.2: libDTSvc Patch (dtmail).

105284-31 recommended Motif 1.2.7: Runtime library patch.

7

106980-10 required Libthread Patch. Apply this patch last.

107636-03 required X Input & Output Method Patch.

107081-11 required Motif 1.2.7 and 2.1.1: Runtime library patch for
Solaris 7

108376-03 required OpenWindows 3.6.1 Xsun Patch. This patch is
required in Asian locales.

8 Not Applicable No patches are required or recommended.
BMC Software, Inc., Confidential and Proprietary Information
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Step 4 Get the appropriate file based on patch numbers. See “Applying Sun
Solaris Patches to Run Service Reporting Aggregators” on page 4-12

Step 5 Expand and untar the file to create a patch directory, for example,
"105490-07."

Step 6 Run as root:

/usr/sbin/patchadd

giving it the patch directory. For example,

/usr/sbin/patchadd 105490-07

The commandpatchadd might indicate that you need to install other
patches first or in single-user mode.

Verify Hardware and Software Requirements

Use the following tables to verify that you have the correct hardware a
software levels to optimize the performance of Service Reporting.

Hardware Requirements

The following tables outline the various hardware requirements for th
different components of Service Reporting. Table 4-4 shows the
minimum and recommended hardware requirements for running
DataStore.

Table 4-5 outlines the hardware requirements for running the Report
Server on a different computer than the computer running DataStore.
you are running them on the same machine, take that into account w
calculating your system hardware requirements.

Table 4-6 outlines the hardware requirements for running all Service
Reporting components on one computer.
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The data aggregator must be running on a computer that has at least
MB RAM with a network connection to the DataStore.

Software Requirements

Table 4-7 outlines the software requirements for the different
components of Service Reporting.

Table 4-4 DataStore Hardware Requirements

Component Minimum Recommended

CPU 350 MHz 500 MHz

Memory 512 MB RAM 1024 MB RAM

Storage 10 GB Disks 20 GB Disks

Table 4-5 Reporting Hardware Requirements

Component Minimum Recommended

CPU 350 MHz 500 MHz

Memory 1024 MB RAM 2048 MB RAM

Storage 4 GB Disks 8 GB Disks

Table 4-6 Hardware Requirements for Running All Service Reporting
Components on One Computer

Component Minimum Recommended

CPU 400 MHZ Two 500 MHz

Memory 1024 MB RAM 2048 MB RAM

Storage 20 GB Disks 40 GB Disks

Table 4-7 Service Reporting Software Requirements

Component Software Version

DataStore Microsoft Windows NT Server
Sun Sparc Solaris

4.0, Service Pack 4 or later
2.7 or later

Data Aggregator &
Retrievers

PATROL® Console 3.4.00 or later

PATROL® Agent 3.4.00 or later
BMC Software, Inc., Confidential and Proprietary Information
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Browser Requirements

Service Reporting includes a QuickReport Editor that you can use to
create report templates based on several generic report types.

You can use the QuickReport Editor with Netscape Communicator
version 4.75 or later, as long as you install the Sun JRE Plug-in, vers
1.3, available on the Website specified on the Service Reporting CD. 
information on installing the JRE 1.3 Plug-in, see “Installing the JRE 1
Plugin to Run the QuickReport Editor on Sun Solaris” on page 6-15.

Note
To run the QuickReport Editor, you must be running Netscape
Communicator Web browser version 4.75 or later on Sun Solaris 2.8.

Recommendations for Sun Solaris Installation Locations

The following table recommends locations for installing the various
Service Reporting components. The table makes the following
assumptions:

• The PATROL Console is already installed on the computer identifi
in the table as the Sun Solaris Console.

• PATROL Agents are already installed on any or all of the compute
(Console, Server, Managed).

• You will install retrievers and aggregators on the same computers
with PATROL Agents.

Reporting Components Apache 1.3.9 or later

Netscape Web Server 3.51 and 3.6

Netscape Browser 4.5 or later (excluding 6.x) on NT
4.75 or later (excluding 6.x) on
Sun Solaris

Sun JRE Plug-In 1.3 or later

Table 4-7 Service Reporting Software Requirements

Component Software Version
BMC Software, Inc., Confidential and Proprietary Information

Pre-Installation Information for Service Reporting on Sun Solaris 4-16



• The Service Reporting Studio can only be installed on a Windows
NT computer (only available when licensed for PATROL Service
Manager).

Table 4-8 Option 1 - Installing Service Reporting Components in a Sun Solaris Environment

On the Destination Computer

To install the
following Service
Reporting
Component

Use the
following
Installation
Option

Sun
Solaris
Console

Sun
Solaris
Server

Managed
Computers
(Windows
NT or Sun
Solaris)

Client
Computer
(Windows
NT or Sun
Solaris)

DataStore Console
Install Data
Collection
Components

✔ (NT)

Aggregator Console KM ✔ ✔

Retrievers Console KM ✔ ✔

Retrievers ✔

Data Aggregator ✔ or ✔

Report Server for Sun
Solaris Install

Reporting
Components

✔

QuickReports ✔ ✔ (NT)

Solution Reports ✔

Web Agent ✔

DataStore Server
DataStore Instance

Install
Database
Components

✔
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Installing Service Reporting on Sun
Solaris 5

This chapter describes the procedure for installing Service Reporting
a Sun Solaris computer, and contains the following topics:

Installation Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

General Installation Recommendations . . . . . . . . . . . . . . . . . . . . 5
Installing DataStore Components on Solaris . . . . . . . . . . . . . . . . 5
Installing Reporting Components on Sun Solaris  . . . . . . . . . . . . 5

Installation Verification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Uninstalling Service Reporting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
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Installation Overview
Since every production environment is unique, it is impossible to
describe every possible configuration. You are the most knowledgeab
person about where you want your consoles (DataStore and PATROL
Report Server, DataStore (server and instance), and Web client
components installed to optimize productivity and response time. This
chapter provides guidelines and recommendations for configuring yo
system in a Solaris environment.

Note
When installing Service Reporting in a Sun Solaris environment you s
need a Windows NT computer for the following components:
~ DataStore Console
~ Administrator Desktop
~ Reporting Studio

To successfully install DataStore and Reporting components on Sola
you must:

• Have an Apache or Netscape Web Server installed and running
• Perform pre-installation tasks (Chapter 4, “Pre-Installation

Information for Service Reporting on Sun Solaris”)
• Install the Reporting components you want (“Installing Reporting

Components on Solaris” on page 5-13)
• Extract and configure the Reporting components laid down during

the installation process (“Extracting and Configuring Reporting
Components on Solaris” on page 5-16)

• Tune kernel parameters (“Tuning Kernel Parameters on Sun Sola
on page 4-8)

• Apply the appropriate system patches (“To Install the JRE Plugin
When Running the QuickReport Editor on Sun Solaris” on page
6-15)

The chapter is organized in three sections —

• Installation
• Installation validation
• Uninstalling
BMC Software, Inc., Confidential and Proprietary Information
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You use the installation program to install Service Reporting to the Su
Solaris computer you are currently logged onto, or as a network
installation on computers that are members of your local domain. The
installation program lets you install Service Reporting components on
one Sun Solaris computer or onto multiple computers at one time,
including to your computer.

Note
If you are migrating from an earlier version of Service Reporting, refer
the current version of Service Reporting release notes for information
BMC Software, Inc., Confidential and Proprietary Information
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Installation
Section 1 describes how to install Service Reporting components in a
Sun Solaris environment.

General Installation Recommendations

• BMC Software recommends installing the PATROL® Console
nearby but not on the computer where the DataStore and Report
Server will be installed. This reduces resource consumption issue

• To optimize performance and minimize the installation time
required, BMC Software recommends using the CD to install
everything,except retrievers, locally when possible.

• Use remote installation for retrievers and aggregators when install
to multiple hosts.

• In a high capacity production environment, BMC Software
recommends installing the Report Server and the DataStore data
on separate servers.

Warning
If you decide to upgrade to the next version of DataStore by installing t
full DataStore Server and DataStore Instance rather than migrating,you
will lose all your existing data.
You cannot install the DataStore Server or DataStore Instance over a
existing installation. You must uninstall them before installing the new
version.

Installing DataStore Components on Solaris

To successfully install DataStore components on Solaris, you must:

• Have an Apache or Netscape Web Server installed
• Install the DataStore components you want (“Installing the DataSto

and DataStore Instance” on page 5-6 and “Installing the DataStor
and Client” on page 5-9)

• Tune kernel parameters (“Tuning Kernel Parameters on Sun Sola
on page 4-8)
BMC Software, Inc., Confidential and Proprietary Information
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• Apply the appropriate system patches (“Applying Sun Solaris
Patches to Run Service Reporting Aggregators” on page 4-12)
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Installing the DataStore and DataStore Instance

In this section you install the DataStore and the DataStore Instance. 
“Installing the DataStore and Client” on page 5-9 to install the DataSt
Client and retrievers.

The combination of the DataStore Server and Instance requires a
minimum of 20 GB for successful installation. In addition a DataStore
Server running on Solaris requires 1 GB of memory.

Note
If it is impractical to run a browser on your Solaris computer, then you
can runsetup.sh -serveronly.
Note the URL that is displayed in the window. On another machine (N
for example) enter that URL into your browser and complete the insta
from there. The pre-installation tasks do not apply to this type install.

To enhance performance, BMC Software recommends installing the
DataStore database and instance on a separate machine from the
DataStore Client.

Step 1 Insert the DataStore CD into the CD-ROM drive and entersetup.shto run
the installation utility and display the Welcome to the Installation Utilit
page.

Step 2 On the Welcome to the Installation Utility page, click Next to display the
Review License Agreement page.

Step 3 On the Review License Agreement page, selectAccept to continue with
the installation and clickNext to display the Select Type of Installation
page.
BMC Software, Inc., Confidential and Proprietary Information
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Step 4 On the Select Type of Installation page, clickTypical or Custom and then
Next to display the Specify Installation Directory page.

Note
TheTypical install path offers a quick installation path with fewer panels
and uses default specifications. BMC Software strongly recommends
using theCustom path for greater control over your installation
configuration. Choose theTypical path if you are installing the product
for the first time, or are new to the product. Choose theCustom
installation path if you are an advanced user and want to customize t
installation configuration. For the purposes of this example, theCustom
installation path is described.

Step 5 On the Specify Installation Directory page, specify the location where
you want to install Service Reporting in theBMC Products Installation
Directory field. The default directory is/opt/bmc/. When finished, click
Next to open the Select Products and Components to Install page.

Warning
You must install data collection components (aggregators and retrieve
in the PATROL home directory, that is, the directory you installed
PATROL into. BMC Software recommends installing reporting and
database components into separate directories.

Step 6 On the Select Products and Components to Install page, expand all t
and select Aggregator, DataStore Instance, DataStore Server and
DataStore Client, Retrievers, Aggregator Console KM and Retrievers
Console KM boxes. If you want to install retrievers remotely, BMC
Software recommends a separate pass using Export. ClickNext to display
the DataStore Family Product Installation Directory page.

Step 7 On the DataStore Family Product Installation Directory page, specify 
PATROL Product Installation Directory (if other than the default) and th
BMC Software, Inc., Confidential and Proprietary Information
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PATROL Agent login name and password. ClickNext to display the DS
Server Properties page.

Note
If you have installed PATROL 3.4.11 you must replace Patrol3 with
PATROL3.4. If you have installed PATROL 3.5, you can use the defau
directory Patrol3.

Step 8 On the DS Server Properties page, specify the Server’s Local Bin
Directory (if other than the default) and the Root login name and
password. ClickNext to display the Review Selections and Install page

Step 9 On the Review Selections and Install page, review your selections an
click Install .

Step 10 Watch the Installation Status page to verify that the DataStore installat
installed successfully. ClickNext to display the SUCCESS! page.

Step 11 On the SUCCESS! page, clickView Log File to review the installation
log file. When you are done, clickFinish.
BMC Software, Inc., Confidential and Proprietary Information
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Installing the DataStore and Client

BMC Software recommends installing the DataStore Client on the
Service Reporting machine if the Service Reporting machine is differe
from the DataStore machine.

Step 1 Insert the DataStore CD into the CD-ROM drive and entersetup.shto run
the installation utility to display the Welcome to the Installation Utility
page.

Step 2 On the Welcome to the Installation Utility page, clickNext. to display the
Review License Agreement page.

Step 3 On the Review License Agreement page, selectAccept to continue with
the installation and clickNext to display the Select Type of Installation
page.

Step 4 On the Select Type of Installation page, clickTypical or Custom and then
Next to display the Specify Installation Directory page.

Note
TheTypical install path offers a quick installation path with fewer panels
and uses default specifications. BMC Software strongly recommends
using theCustom path for greater control over your installation
configuration. Choose theTypical path if you are installing the product
for the first time, or are new to the product. Choose theCustom
installation path if you are an advanced user and want to customize t
installation configuration. For the purposes of this example, theCustom
installation path is described.

Step 5 On the Specify Installation Directory page, specify the location where
you want to install Service Reporting in theBMC Products Installation
Directory field. The default directory is/opt/bmc/. When finished, click
Next to open the Select Products and Components to Install page.

Step 6 On the Select Products and Components to Install page, expand all t
and select DataStore Client and Retrievers boxes. If you want to insta
retrievers remotely, BMC Software recommends a separate pass usin
BMC Software, Inc., Confidential and Proprietary Information
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Export. ClickNext to display the DataStore Family Product Installation
Directory page.

Step 7 On the DataStore Family Product Installation Directory page, specify 
PATROL Product Installation Directory (if other than the default) and th
PATROL Agent login name and password. ClickNext to display the DS
Server Properties page.

Step 8 On the DS Server Properties page, specify the Server’s Local Bin
Directory (if other than the default) and the Root login name and
password. ClickNext to display the Review Selections and Install page

Step 9 On the Review Selections and Install page, review your selections an
click Install .

Step 10 Watch the Installation Status page to verify that the DataStore installat
installed successfully. ClickNext to display the SUCCESS! page.

Step 11 On the SUCCESS! page, clickView Log File to review the installation
log file. When you are done, clickFinish.
BMC Software, Inc., Confidential and Proprietary Information
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Starting and Stopping DataStore on Unix

When DataStore is installed on a Unix computer you must stop it befo
you shutdown or restart your system. Once the system is up again, y
must restart DataStore.

Warning
When DataStore is installed on a Unix computer, it is critical to make
database backups a routine part of system administration. If the comp
shuts down in an abnormal fashion—a power outage for instance—w
DataStore is running, the DataStore database will be corrupted. Your
only recourse is to restore the last backup to rebuild the database. Fo
more information, refer to theDataStore Administrator Guide.

BMC Software recommends including the DataStore shutdown
procedure as part of the Solaris computer’src stop scripts. Including it in
the shutdown script offers you an additional degree of reliability.

You can include the DataStore start up procedure as part of the Solar
computer’src start scripts. Including it in the start script offers you a
degree of reliability.

Step 1 Log on to the machine using your valid user ID.

Step 2 Change directory (cd), if necessary, to a directory where you have wr
permissions because a temporary file is written there.

Step 3 Make sure the ORACLE_HOME environment variable is set to the
ora815 directory and that the ORACLE_SID environment variable is se
to BMCEDS.

Step 4 Use theaggcli command from the PATROL Console in
$PATROL_HOME/sr/bin  to stop any aggregator connected to DataStor
The command is:

$PATROL_HOME/sr/bin/aggcli -p 4568 -a <aggregator_node> -c aggexit

Step 5 Run$ORACLE_HOME/bin/oraadm immediate.
BMC Software, Inc., Confidential and Proprietary Information
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Step 6 Shut down the machine.

Use the following procedure to start or restart the DataStore Server:

Step 1 Log on to the machine using your valid user ID.

Step 2 Change directory (cd), if necessary, to a directory where you have wr
permissions because a temporary file is written there.

Step 3 Make sure the ORACLE_HOME environment variable is set to the
ora815 directory and that the ORACLE_SID environment variable is se
to BMCEDS.

Step 4 Run$ORACLE_HOME/bin/oraadm start .

Installing Reporting Components on Sun Solaris

To successfully install Reporting components on Solaris, you mus
have an Apache or Netscape Web Server installed. The following
sections describe how to install Reporting components.
BMC Software, Inc., Confidential and Proprietary Information
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Installing Reporting Components on Solaris

Use the following procedure to install Reporting components on your
Solaris version 7 or 8 computer.

Note
If it is impractical to run a browser on your Solaris computer, then you
can runsetup.sh -serveronly.
Note the URL that is displayed in the window. On another machine (N
for example) enter that URL into your browser and complete the insta
from there. The pre-installation tasks do not apply to this type of insta

Step 1 Log on as the non-root user who will own the installation.

Step 2 Insert the Service Reporting CD into the CD-ROM drive, cd to the top
level directory of the CD-ROM, and enter the following command to ru
the installation utility and display the Welcome to the Installation Utilit
page:

setup.sh

Step 3 On the Welcome to the Installation Utility page, click Next to display the
Review License Agreement page.

Step 4 On the Review License Agreement page, clickAccept to continue with
the installation and clickNext to display the Select Type of Installation
page.
BMC Software, Inc., Confidential and Proprietary Information
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Step 5 On the Select Type of Installation page, clickTypical or Custom and then
Next to display the Specify Installation Directory page.

Note
TheTypical install path offers a quick installation path with fewer panels
and uses default specifications. BMC Software strongly recommends
using theCustom path for greater control over your installation
configuration. Choose theTypical path if you are installing the product
for the first time, or are new to the product. Choose theCustom
installation path if you are an advanced user and want to customize t
installation configuration. For the purposes of this example, theCustom
installation path is described.

Step 6 On the Specify Installation Directory page, specify the base directory
under which you anticipate installing various BMC products, including
Service Reporting, in theBMC Products Installation Directory field. The
default directory is/opt/bmc. When finished, clickNext to open the Select
Products and Components to Install page.

Note
You must have write permissions for this directory.

Step 7 On the Select Products and Components to Install page, expand all t
and select all boxes.

To speed installation, install only the Solution Reports for the Knowled
Modules (KMs) for which your site is licensed to collect data.

Note
The QuickReport Editor is not an installation option. It is automatically
installed when you install other Reporting components.

Step 8 Click Next to display the Specify Logon page.

Step 9 On the Service Reporting Installation Directory page specify the name
the directory created in the BMC Products Installation base directory 
contain the Service Reporting installation (if other than the default) an
the PATROL Agent Login Name and Password (provide the login id a
BMC Software, Inc., Confidential and Proprietary Information
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password of the installer). ClickNext to display the SR Web Agent
Properties page.

Step 10 On the SR Web Agent Properties page, specify the Root Login Name
the Password. ClickNext to display the Review Selections and Install
page.

Step 11 On the Review Selections and Install page, review your selections an
click Install . If there is insufficient disk space, you are alerted here.

Step 12 Watch the Installation Status page to verify that the Service Reporting
installation process completes successfully. When the installation is
complete, clickNext.

Step 13 On the SUCCESS page, clickView Log File to review the installation log
file. When you are done, clickFinish. The Reporting components are
now installed on your system.
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Extracting and Configuring Reporting Components on Solaris

During the installation process, files are laid down to install the:

• Java RunTime Environment (JRE)
• Publisher and Zone Index Servers
• Reporting Portal Application

Note
Note the path to your Service Reporting Install Directory. The followin
procedures refer to the path as <Service Reporting installation
directory>.

The following sections describe how to extract and configure the vario
Reporting components.

Locating and Installing the JRE 1.3.1

Step 1 Change directory to <Service Reporting installation
directory>/JRE/temp_jre.

Step 2 Runcheck_jres.sh to check your machine for the presence of JRE 1.3.1

Step 3 Do one of the following:

• If JRE 1.3.1 is present:

• Run export JAVA_HOME  = <path to JRE installation>.
• Go to “Setting Environment Variables” on page 5-17.

• If JRE is not present, do the following to install JRE 1.3.1:

• Change directory to <Service Reporting installation
directory>/JRE.

• Run ./temp_jre/j2re-1_3_1-solsparc.sh to extract the JRE files in
the current directory.
BMC Software, Inc., Confidential and Proprietary Information
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Setting Environment Variables

Step 1 Change to the <Service Reporting installation directory>/JRE/temp_jre
directory.

Step 2 Run ./configure_jre.sh to initialize global environment files.

Step 3 If you have insufficient rights, the script terminates with a relevant
message. If this occurs, superuser to root and re-run the script.

Note
Once the JRE installs, you can remove thetemp_jre directory.

If you want the Reporting Portal environment variables fully configure
when you login, add the following line to your .profile or .kshrc file.

. /var/opt/bmc/sr/rp_envt.default

Note
There is a space between the period (.) and the word/var.

Installing the Publisher and Zone Index Servers

Step 1 Change to the <Service Reporting installation directory>/publisher/bin
directory.

Step 2 Runconfig_pubsvr.sh.

Step 3 Superuser to Root (su root).
BMC Software, Inc., Confidential and Proprietary Information
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Step 4 Run ./create-rc-links.sh -s pubsvr to configure the rc scripts for automatic
startup and shutdown of the Publisher Server.

Note
If, when you runcreate-rc-links.sh -s <servername>, the link already
exists, you will get an error message.  This occurs only during
subsequent installations.  To update the links, runrm-rc-links.sh -s
<servername>, then re-runcreate-rc-links.sh -s <servername>.

Step 5 Run ./create-rc-links.sh -s zisvr to configure the rc scripts for automatic
startup and shutdown of the Zone Index Server.

Step 6 EnterExit  so that you are no longer user root.

Step 7 Start up the servers by running
./pubserver.sh start
and
./ziserver.sh start

Installing the Reporting Portal

Step 1 Change directory to<Service Reporting installation directory>/temp_rpi.

Step 2 Run the installation scriptinstall_rportal.sh.

Step 3 Superuser to Root (su root).

Step 4 If the following message appeared while running install_rportal.sh, yo
did not have adequate permissions to update the Apache Web Serve
configuration.

$PUBLISHER_HOME/config/include_line must be
appended to $WEBSERVER_CONF

To correct this, run./setup_apacheconf.sh or ./setup_iplanetconf.sh.

Step 5 Runcreate-rc-links.sh -s tomcat to configure the rc scripts for automatic
startup and shutdown of Tomcat.
BMC Software, Inc., Confidential and Proprietary Information

5-18 Service Reporting Getting Started



t the

er

e-
Step 6 Change to your Apache or Netscape Web Server directory and restar
web server.

Step 7 EnterExit  so that you are no longer user root.

Step 8 Change directory to the <Service Reporting installation
directory>/AcServer/bin.

Step 9 Run ./shutdown_srvr.sh -y.

Step 10 When that finishes, run./start_srvr.sh.

Step 11 When that finishes, test the Reporting Portal install. Go to your brows
and enter the URLhttp:// hostname/rportal/index.html .

Installation Verification
• In order to successfully install the DataStore onto the Sun Solaris

operating environment you must complete a series of pre- and
post-installation steps. For more information on these required pr
and post-installation steps, seeOracle8i Installation Guide Release 2
(8.1.7) for Sun SPARC Solaris.

• To see if DataStore is installed correctly, execute the Unixps -ef |grep
BMCEDS command to locate the following processes.

• Database
• ora_pmon_BMCEDS
• ora_dbw0_BMCEDS
• ora_ckpt_BMCEDS
• ora_lgwr_BMCEDS
• ora_smon_BMCEDS

• LISTENER
• tnslsnr listener -inherit

• Data collection
• sr_eventret
• sr_historyret
• sr_agg
BMC Software, Inc., Confidential and Proprietary Information
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• Report Server
• admserv4
• pobserv4
• reqserv4

• Web Agent (ps -ef |grep AcServer/bin*)
• AcServer/bin/admserv4
• AcServer/bin/pobserv4
• AcServer/bin/reqserv4

• Virtual X Server (ps -ef |grep Xvfb)
• ./Xvtb

• Verify the database connection. See theDataStore Administrator
Guide for instructions on how to validate the database connection

• View the Service Reporting Website.

Uninstalling Service Reporting
To remove Service Reporting components from your computer you m
remove the data collection components seperately from reporting
components on Unix.
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Uninstalling Reporting Components on Sun Solaris

Step 1 Set environment variables by running:

. /var/opt/bmc/sr/rp_envt.default

Note
There is a space between the period and the first back slash.

Step 2 Add the current directory to the path.

export PATH=$PATH:.

Step 3 Uninstall the Reporting Portal and Tomcat server.

3.A Change directories to <Service Reporting home>.

3.B Switch user to root.

su root

3.C Remove the link for the Tomcat server by running:

$TOMCAT_HOME/bin/rm-rc-links.sh -s tomcat

3.D Exit from user root.

3.E Remove the Reporting Portal and Tomcat server by running:

uninstall_rp_tc.sh script

Step 4 Uninstall the Publisher and Zone Index servers.

4.A Change directories to <Service Reporting home>.

4.B Switch users to root.
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4.C su root

4.D Remove the link for the Publisher server by running:

./publisher/bin/rm-rc-links.sh -s pubsvr

4.E Remove the link for the Zone Index server by running:

./publisher/bin/rm-rc-links.sh -s zisvr

4.F Exit from user root.

4.G Remove the Publisher and Zone Index servers by running:

./uninstallsrvrs.sh
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Uninstalling DataStore on Sun Solaris

You run the BMC Software Uninstall program to remove the DataStor
component of Service Reporting.

Step 1 Change directories to<installationdirectory>/Uninstall.

Step 2 Rununinstall.sh.

Step 3 On the Welcome to Installation Utility - Uninstall Mode page, clickNext
to display the Select Type of Uninstall page.

Step 4 SelectSelected Products, and clickNext to display the Specify
Installation Directory page.

Step 5 Verify the directory path, and clickNext to display the Select Products
and Components to Uninstall page.

Step 6 Select DataStore, and clickNext to display the Review Selections and
Uninstall page.

Step 7 Click Uninstall to display the Uninstall Status page.

Step 8 Watch the Uninstall Status page to verify that the process is complete
When it has completed, clickNext.

Step 9 On the SUCCESS! page, clickView Log File to review the installation
log file. When you are done, clickFinish.

Step 10 Change to your Apache or Netscape Web Server directory and restar
web server.
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Configuring Service Reporting 6

This chapter describes how to configure Service Reporting and includ
the following topics:

Overview of Configuring Service Reporting . . . . . . . . . . . . . . . . . . . 6-
Configuring Data Collection Components . . . . . . . . . . . . . . . . . . . . . 6
Configuring Reporting Components. . . . . . . . . . . . . . . . . . . . . . . . . . 6

Maintaining Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Adding Users to the Service Reporting Report Server  . . . . . . . . 6
Connecting the Report Server to the DataStore . . . . . . . . . . . . . . 6
Synchronizing the Report Server with the DataStore for Data

Summarization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Changing the Default Notification Setting for the Completed

Requests Folder  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Installing the JRE 1.3 Plugin to Run the QuickReport Editor on Su

Solaris . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Display Issues  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Using the Log File Cleanup Tool . . . . . . . . . . . . . . . . . . . . . . . . . 6

Automate Database Startup and Shutdown (Optional). . . . . . . . . . . . 6
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Overview of Configuring Service Reporting

Configuration in Service Reporting is separated between the
configuration of data collection components, which includes data
aggregators and retrievers, and the configuration of reporting
components, which includes connecting the Report Server to the
DataStore.

In the configuration of data collection components you connect the
components together to ensure that collected data is passed from the
event or history retriever to the data aggregator and from there, to the
DataStore. For more information on using the data collection
components in your environment, see theDataStore Administrator
Guide.

For reporting components, the configuration primarily concentrates o
security issues dealing with account name and password information
connecting the Report Server to the DataStore. For more information
reporting components, see theReporting User Guide and Actuate
documentation which can be found on the PATROL Performance
Documentation CD.

There is a final section which describes how create start-up scripts th
run both DataStore and Reporting components.
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Configuring Data Collection Components

In Service Reporting data collection components must be configured 
connect retrievers to the data aggregator and the data aggregator to 
DataStore. For configuration, the DataStore Knowledge Module is us
with a PATROL Operator or Developer Console. The DataStore KM
allows you to configure, start, stop, and monitor data aggregators and
retrievers in your environment locally or remotely.

Local configuration only configures the data aggregator or retriever
located on the computer you are currently logged on. Remote
configuration allows you to configure multiple data aggregators or
retrievers contained within your environment, including the local
computer. Before you can configure remote data aggregators or retrie
you must first add their host information to the remote host list.

Once you have configured the data aggregators and retrievers in you
environment, the settings are sent to the PATROL Agent hosting the
retrievers or data aggregator.

Note
Figure 6-1 and Table 6-1 list the minimum tasks required to quickly
begin collecting data. For additional information on configuring data
collection components, see theDataStore Administrator Guide.

Figure 6-1 Steps to Set Up Data Collection

Configure Data Aggregator(s)

Load DataStore KM

4

5

Load the DataStore KM using a PATROL
Console.

Add Hosts to Remote Host2 Add computers to the remote host list.

3

1

Configure History Retrievers

Configure Event Retrievers

Set up the connection between data
aggregator(s) and the DataStore.

Set up the connection between event
retrievers and data aggregator(s).

Set up the connection between history
retrievers and data aggregator(s).
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Table 6-1 Data Collection Configuration Steps  (Part 1 of 2)

Step Commands to use in the PATROL Console Notes

Load the
DataStore KM

• Start a PATROL Developer Console.
• Choose File => Load KM .
• Locate SERVICE_RPT.kml and click Open .

The SR_DATASTORE
application class
appears in the bottom
portion of the PATROL
Console.

Add hosts to
the remote
host list

• Right-click the SR_DATASTORE  application class
and choose KM Commands => Remote
Administration => Add Hosts.

• Enter the Host Name, PATROL Agent port number,
user name, and password for each agent where a
data aggregator or retriever is installed and click Add .

• Click Done  when you have added all the hosts you
want.

The remote host list is
used to configure
remote data
aggregators and
retrievers.

Configure data
aggregators

To configure the local data aggregator
• Expand the SR_DATASTORE  application class.
• Right-click the Aggregator application instance and

choose KM Commands => Administration =>
Configure Aggregator .

• Enter the name of the computer hosting the Service
Reporting DataStore, using eda_user as the
database username/eda as the database password,
and then click Save.

To configure remote data aggregators
• Right-click the SR_DATASTORE  application class

and choose KM Commands => Remote
Administration => Config. Remote Aggregator .

• Select the hosts of the data aggregators you want to
configure and click OK.

• Select three as the logging level of detail. It helps
when it comes to debugging.

• Enter the name of the computer hosting the Service
Reporting DataStore, use eda as the database
password, and then click Send .

Once you click Save or
Send , the configuration
settings for the data
aggregator(s) are sent
to the PATROL Agent(s).

Warning : Do not
change the database
port, database instance,
database username, or
aggregator port. The
other fields can be
changed; however, the
recommended settings
are selected. See the
online Help for details.
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To configure the local history retriever
• Click the SR_DATASTORE  application class.
• Right-click the HistoryRet_<port>  application

instance and choose KM Commands =>
Administration => Configure History Retriever .

• Select three as the level of detail. It helps when it
comes to debugging.

• Enter the name of the computer hosting the data
aggregator to which you want to connect the retriever
and click Save.

To configure remote history retrievers
• Right-click the SR_DATASTORE  application class

and choose KM Commands => Remote
Administration => Config. Remote History Retrvr.

• Select the hosts of the history retrievers you want to
configure and click OK.

• Select three as the level of detail. It helps when it
comes to debugging.

• Enter the name of the computer hosting the data
aggregator to which you want to connect the
retrievers and click Send .

Once you click Save or
Send , the configuration
settings for the history
retriever are sent to the
PATROL Agent.

Configure
event retrievers

To configure the local event retriever
• Click the SR_DATASTORE  application class.
• Right-click the EventRet_<port> application instance

and choose KM Commands => Administration =>
Configure Event Retriever .

• Enter the name of the computer hosting the data
aggregator to which you want to connect the retriever,
and then enter the PATROL user name and password
of the agent on the retriever computer, and click
Save.

To configure remote event retrievers
• Right-click the SR_DATASTORE  application class

and choose KM Commands => Remote
Administration => Config. Remote Event Retrvr.

• Select the hosts of the event retrievers you want to
configure and click OK.

• Enter the name of the computer hosting the data
aggregator to which you want to connect the
retrievers, and click Send .

Once you click Save or
Send , the configuration
settings for the event
retriever are sent to the
PATROL Agent.

Table 6-1 Data Collection Configuration Steps  (Part 2 of 2)

Step Commands to use in the PATROL Console Notes
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Configuring Reporting Components
The configuration of the reporting components for Service Reporting 
limited to assigning new account and password information and
connecting the Report Server to the DataStore.

Maintaining Security

As reporting components are installed, they are installed using defau
account and password information. Table 6-2 lists default account na
and password settings that you will want to change to ensure that you
environment is secure.

Table 6-2 User Account and Password Settings

Account / Password Description Additional Information

Report Server User
Account and Password

During installation, the report server uses
the account of the user who installed the
product. However, you may want to specify
another account to ensure that system
facilities, such as e-mail notification, and
ODBC connections are aware of the
report server account.

For more information on
setting up a new Report
Server account, see the
Actuate Report Server
Guide.

Report Encyclopedia
User Account and
Password

In the Report Encyclopedia there are user
accounts already defined. The
Administrator account for the Report
Encyclopedia does not have a password
setting. To improve the security of the data
in the Encyclopedia you may want to add
a password setting not only for the
Administrator account but also for other
user accounts also.

The PATROL account uses the default
username “patrol” and password “patrol”
and has administrator privileges.

For more information on
setting up user accounts and
passwords for the Report
Encyclopedia, see the
Actuate document
Administering the Report
Encyclopedia.
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Adding Users to the Service Reporting Report Server

Three additional users have been added to the Service Reporting Re
Server. The new users provide specific access to the Report Server du
installation, Report Server operations, and QuickReport Editor
processing.

Upon installation, the following users are added to the Report Server:

During normal operations, typically the only active users are sr_user 
administrative purposes, and sr_viewer for report viewing.

The Site User is a new role that lets you add additional users. You cre
new users and add them to the SiteUser role.

Note
If you want to schedule new reports with new users, you do not need
unschedule existing reports. However, if you change the Patrol/Patrol
username and password, existing Solution Reports will not run. You m
unschedule the existing Solution Reports and reschedule them.

Table 6-3 User Names and Passwords for the Report Server

User Name/Password Roles Function

patrol/patrol Administrator Used during the
installation process.
Do not change the
user name or
password.

qre_user/qre Administrator Used by the
QuickReport Editor to
process report
templates. Do not
change this password.

sr_user/sruser Administrator Used by the Report
Server administrative
user.

sr_viewer/[no password] Site User Used by SiteUser to
view reports. Has
limited rights.
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Creating and Assigning New Users

Step 1 Log on to the Report Server usingUser name: sr_user andPassword -
sruser.

Step 2 Right-click Users and clickNew User.

Step 3 Enter the User name and New password.

Step 4 Confirm password.

Step 5 Click theRoles tab.

Step 6 Click twice in the box next to the SiteUser role.

Step 7 Click OK .

Step 8 Repeat for each user.
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6-8 Service Reporting Getting Started



on

re
Connecting the Report Server to the DataStore

If you install the DataStore and the Report Server onto different
machines, you must run the Net8 Assistant utility provided by Oracle 
the computer hosting the Report Server to connect to the DataStore.

Connecting the Report Server to the DataStore on Windows NT
and Sun Solaris

Summary: This task describes how to connect the Report Server to the DataSto
located on another computer.

Step 1 Do one of the following to open the Net8 Assistant dialog box.

1.A On Windows NT.
Start => Programs =>BMC PATROL => Service
Reporting => Net8 Assistant.

1.B On Sun Solaris.

• Set the following environment variables
ORACLE_SID=BMCEDS
ORACLE_HOME =Where Oracle is installed
TNS_ADMIN  =/$ORACLE_HOME/network

• Run /ora815/bin/netasst on Solaris to get into the Oracle
Client.
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The Net8 Assistant dialog box appears.

Figure 6-2 Net8 Assistant

Step 2 Highlight Net Service Names and click + to add the service name.

The Net Server Name Wizard appears.

Figure 6-3 Net Server Name Wizard Page 1
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Step 3 In the Net Service Name text box, enter the service name and clickNext.

Step 4 In the list box, select the TCP/IP (Internet Protocol) selection and clic
Next.

Figure 6-4 Net Service Name Wizard Page 2
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Step 5 Enter the host name and port number for the computer hosting the
DataStore and clickNext.

Figure 6-5 Net Service Name Wizard Page 3

Step 6 Select theOracle8i release 8.1 option box and enter the Service name, th
actual name of the database, the default is bmceds, and clickNext.

Figure 6-6 Net Service Name Wizard Page 4
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Step 7 In the last page of the Net Service Name Wizard, clickFinish or click
Test to verify that you can log into the database.

The Net8 Assistant dialog box appears.

Step 8 Highlight the service name you just created and chooseFile => Save
Network Configuration to save the database settings.

Synchronizing the Report Server with the DataStore for
Data Summarization

In the DataStore, data summarization creates summarized data using
time zone specified in the Time Zones dialog box. However you must
make sure that the Report Server is correctly synchronized with the
DataStore to ensure that reports display the correct time zone informa
from the data summarized.

Note
For information on time zones, see theDataStore Administrator Guide.

To make sure that the Report Server is synchronized with the DataSt
BMC Software installs several scripts that you can run to determine w
settings the DataStore and Report Server are using for data
summarization. Table 6-4 lists the available scripts and provides a bri
description of their purpose. The scripts are located in
%PATROL_SR_ROOT%/bmcreports/install . For more information on
using the data summarization scripts, see theDataStore Administrator
Guide.

Table 6-4 Report Server Data Summarization Scripts  (Part 1 of 2)

Script Purpose

tz_util testc Verify that you are able to connect to the DataS-
tore from the Report Server.

tz_util qdben View the time zone currently being used for data
summarization in the DataStore.
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Changing the Default Notification Setting for the
Completed Requests Folder

You receive notification from the Report Server when a report reques
completed. The default setting for theCompleted Requests Folder is to
keep the notifications in the Completed Report Requests folder. You c
reset the notification so that it deletes the notifications, freeing up wo
space and requiring less intervention on your part.

Step 1 In the Administrator Desktop, click theUsers icon in the left pane.  The
right pane displays a list of users that are defined for the Report Serv
The default list is:administrator, patrol, qre_user, sr_user,and sr_viewer.

Step 2 Right-click Administrator  and selectProperties.

Step 3 Select theNotification tab. There are two kinds of completed requests:

• Requests that Succeed
• Requests that Fail

The default setting is:Do not automatically delete the notification.

Step 4 Change toAutomatically delete the notification after.

Step 5 Select five days forSucceed and 14 days forFail.

tz_util sdcfg Configure the Report Server to create reports using
the default time zone in the DataStore.

tz_util sscfg Configure the Report Server to create reports using
a DataStore time zone id.

tz_util qdbal View a list of all time zones supported by the
DataStore.

tz_util soffs Record the GMT offset of the Report Server.

tz_util qcfg Display the current Report Server settings for local
time zone offset and report time zone.

Table 6-4 Report Server Data Summarization Scripts  (Part 2 of 2)

Script Purpose
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You can repeat this process for other users who generate reports.

Installing the JRE 1.3 Plugin to Run the QuickReport Editor
on Sun Solaris

If you are using Netscape Web Browser 4.76 to run the QuickReport
Editor on a Sun Solaris version 8 computer (as opposed to Windows N
the first time you logon to the QuickReport Editor, you need to install th
JRE 1.3 Plugin.

To Install the JRE Plugin When Running the QuickReport
Editor on Sun Solaris

There are two ways to log in to the QuickReport Editor and install the
Java RunTime Environment (JRE) Plugin.

Step 1 If you are running the QuickReport Editor from a different machine th
where it is installed, launch your Web Browser and enter the following
url:
http:// server-name/bmcreports/qre.html
or
http:// server-name/acweb/server-name and double-click theQuickReport
Editor  icon to display the QuickReport Editor Welcome page.

Step 2 On the Report Encyclopedia main page, clickUser: anonymous, Log On
to open the Enter Network Password dialog box.

2.A Enter the user name and password provided by your
administrator. The default is:

User Name: patrol
Password: patrol

2.B Click OK to display theQuickReport Editor icon and name in the
tool bar.

Step 3 Double-click theQuickReport Editor  icon to display the QuickReport
Editor Welcome page.
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Step 4 Download the JRE 1.3 plugin to a local directory. As you are entering t
information, note the file name, directory, and location.

Step 5 Navigate to the directory where the download was installed and
double-click the Java Plug-in Software executable to install it.

Step 6 Run the JRE download to extract the files.

Step 7 Run the following script to set the Netscape Browser pluginjavaplugin.so
path.
NPX_PLUGIN_PATH=`pwd`/jre/1.3.0_02/plugin/sparc/ns4;
export NPX_PLUGIN_PATH

Step 8 Stop and restart the Netscape Browser.

Step 9 Add NPX_PLUGIN_PATH to the user’s.profile shell.
NPX_PLUGIN_PATH=<plugin path >;
export NPX_PLUGIN_PATH

Display Issues

• When you display reports online, the report legends are not
displayed. There is currently no work around for this problem.

• Use the small fonts on your PC’s display setting. Using a large fon
setting might prevent some words from being displayed on reports
on various tabs within the interface.

• Many Service Reporting reports let you query the database for da
on the topn components. However, if data is available for only one
component, the report displays the correct results, but the report 
reflects your original query—the topn you specified. The report
displays the data for the one component followed by blank lines fo
the number of components you specified.

• When you are displaying a summary or solution graph with only o
bar chart, it is oversized and might look awkward.

Note
BMC Software recommends a 1024 x 768 with 16-bit color (65,536
colors) monitor resolution for optimum report viewing on IE 5.0 or late
However, when using Netscape 4.5 or later, use the next higher color
setting (16777216 colors).
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Using the Log File Cleanup Tool

Service Reporting installs a default storage zones for generic and
solution reports in a folder calledDefault. It also sets up a utility storage
zone for log cleanup and retriever status reports calledzz_SysUtils. The
Log File Cleanup Tool manages the two directories by deleting the da
weekly, and monthly logs using predefined deletion criterion.

The Log File Cleanup Tools, data source files, are scheduled at
installation time to run at the following times:

You modify the Cleanup Tool schedules in the same way you modify
Solution Report schedules.

If you define your own storage zones, you must change the existing L
File Cleanup Tool entries for specific storage zones or add new ones.
following sections describe the file location and organization informati
you need to customize the Log File Cleanup Tool.

Log File Cleanup csv File Location

The Log File Cleanup Tools are contained in data source (csv) files.
There is a cleanup file associated with the daily, weekly, and monthly
reports in the following directories.

• bmcreports\cfg\cleanup\filecleanup_daily.csv - daily report cleanup
• bmcreports\cfg\cleanup\filecleanup_weekly.csv - weekly report

cleanup
• bmcreports\cfg\cleanup\filecleanup_monthly.csv - daily report cleanup

Table 6-5 Log File Cleanup Tool Schedule

Cleanup Tool Schedule

Daily cleanup 3 A.M., everyday

Weekly cleanup 3 A.M., every Sunday

Monthly cleanup 3 A.M., first day of each month
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Table 6-6 Log File Cleanup Tool Contents

Column Index Column Name Type Description Example

1 TaskName String Describe the cleanup task.
Should be surrounded by
quotes.

“SR
Temporary
Directory”

2 Platform String Platform on which cleanup is
running. Either 'Windows' or
'Unix'.

Windows

3 Command String Command filename. Should
include the absolute existing
path.

~/install/List
All.bat

4 Output String Prefix for the temporary output
file which contains list of log
file names. The whole output
file name will be
<prefix>yyymmddhhnnss. The
name should include the
absolute path.

~\Default\doc
uments\ListT
mp

5 MarkFile String Prefix for the temporary mark
file name. Whole name will be
<prefix>yyymmddhhnnss. The
name should include the
absolute path.

~\Default\doc
uments\Mark
Tmp

6 UseTemp String A one-character discriminator
which indicates whether or not
to clean the log files in the
bmcreports\Temp directory. "Y"
for Yes, "N" for No.

y

7 BaseDir String Use as the base directory from
which to start the search. Used
only when UseTemp = n. If
UseTemp = y, then leave it
blank.

8 Pattern String Pattern of file name to locate. ERT*.log

9 Age Integer Age (in days) of the files to
locate.

1

10 Command
TimeOut

Integer The length of time in second(s)
to wait for the mark file to be
generated. The default is 10
seconds.

20
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Publisher Server and Zone Index Server Log File Cleanup

Both the Publisher Server and Zone Index Server publish log files tha
are useful troubleshooting tools. Publisher Server logs are located in
%PUBLISHER_HOME%\work\pubsvr\log . Zone Index Server logs are
located in%PUBLISHER_HOME%\work\zisvr\log .

These directories have automatic archival features that limit the size a
number of the log files so it’s not necessary to use the Log File Clean
Tools. The default size limit of the log folder is 5 MB. When the limit is
reached, the old log file is overwritten.
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Understanding the Deletion Criterion

The Log File Cleanup Tool deletes logs from the Default and Temp
storage folders based on the age of the data. The following table gives
log location, it’s deletion criterion, and a brief description.

Note
Unix is case sensitive. You must delete mixed-case file names from th
data source file and substitute lower case names.

Table 6-7 Log File Cleanup Tool Contents

Log Location

Deletion
Criterion
(in days) Description

~\Temp\ERT*.log 1 Delete yesterday’s report log in the Temp directory.

~\Default\documents\*.log 15 Delete the generic report logs that are older than 15
days and are in the Default storage folder.

~\Default\soln\daily\*.log 8 Delete daily solution report logs that are older than
eight days and are in the Default storage folder.

~\Default\soln\weekly\*.log 32 Delete the weekly solution report logs that are older
than 32 days and are in the Default storage folder.

~\Default\soln\monthly\*.log 200 Delete the monthly solution reports logs that are older
than 200 days and are in the Default storage folder.

~\zz_SysUtils\daily\*.log 8 Delete daily cleanup and retriever status report logs
that are older than eight days and are located in the
zz_SysUtils storage folder.

~\zz_SysUtils\weekly\*.log 32 Delete weekly cleanup logs that are older than 32
days and are located in the zz_SysUtils storage
folder.

~\zz_SysUtils\monthly\*.log 200 Delete logs of monthly cleanup reports that are older
than 200 days and are located in the zz_SysUtils
storage folder.

~\..\Server\log.txt 0 Delete log.txt immediately.

~\..\Server\log\*.log 15 Delete the Actuate Report Server log that is
generated before 15 days.
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Modifying the Log File Cleanup Tool

If you set up your own storage zone by modifying the Default storage
zone folder, you must modify the corresponding record in csv files for
the Log File Cleanup Tool to work.

Note
You can only change the\Default folder. You cannot modify the
/zz_SysUtils storage folder.

Example
"~\<myStorageZone>\soln\daily",   Windows,
~\install\Win32\ListAll.bat,
~\<myStorageZone>\documents\ListSoD,
~\<myStorageZone>\documents\MarkSoD, n,
~\<myStorageZone>\soln\daily, *.log, 8, 10

Table 6-8 Modifying the Log File Cleanup Report

Column Number Recommended Modification

1 A string representing the task name. The string
needs to appear in quotes.

2 Windows or Unix.

3 No modification.

4 Change /Default to <myStorageZone>.

5 Change /Default to <myStorageZone>.

6 No modification.

7 Change /Default to <myStorageZone>.

8 No modification.

9 No modification.

10 No modification.
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Adding a New Storage Zone Entry

If you define new storage zones, you must add new records to the csv
to manage the new storage zones.

Note
You can change only the\Default folder to\<myStorageZone>. You cannot
modify /zz_SysUtils.

Example
"~\<newStorageZone>\soln\daily",   Windows,
~\install\Win32\ListAll.bat,
~\<newStorageZone>\documents\ListSoD,
~\<newStorageZone>\documents\MarkSoD, n,
~\<newStorageZone>\soln\daily, *.log, 8, 10

Table 6-9 Adding New Storage Zones to the Log File Cleanup Tool

Column Number Recommended Modification

1 A string representing the task name. The string needs
to appear in quotes.

2 Windows or Unix.

3 Copy the existing command column.

4 Specify the path and file prefix of the temporary output
file such as <myStorageZone>\documents\output.

5 Specify the path and file prefix of the temporary
MarkFile file such as
<myStorageZone>\documents\Mark.

6 Should be a character n.

7 Specify the path of the log files such as
<myStorageZone>\soln\daily>.

8 Specify a pattern for the log files, such as *.log.

9 Specify the deletion criterion as an integer. You can
reference the existing deletion criterion.

10 Specify an integer to represent the time out in seconds.
You can reference the existing time out criterion.
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Start-Up Scripts for Sun Solaris
Service Reporting is installed with start-up scripts to initiate activity on
the Report Server and the Web agents. There is additional documenta
inside each script.

Note
For information on DataStore start-up and shutdown, see “Automate
Database Startup and Shutdown (Optional)” on page 6-25.

Report Server Scripts

There are two Report Server start up scripts which are installed to:

<installdir>/AcServer/bin

• shutdown_srvr.sh
• start_srvr.sh

To automatically start the Report Server whenever the system is
shutdown and rebooted, you must runupdate_rclocal.sh as superuser (the
root id). Theupdate_rclocal.sh installs the start up and shutdown scripts
in the inet.d directory at reboot time.

Web Agent Scripts

There are two Web agent scripts which start and stop the Web agents

• startreportcast.sh installed inwebserverhome/actuate/bin
• stopreportcast.sh installed inwebserverhome/actuate/bin

To findwebserverhome, enter the following command:
ps -ef | grep http

You will get a response similar to:
/doc/webserver/netscape/ etc
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Go to /doc/webserver/netscape to look foractuate/bin. When you find
actuate/bin, look for the reportcast start and stop scripts.

Sample Script

The following is a sample script which you can use as a model for yo
own site. The pound sign (#) represents a comment.

Note
All scripts must be tailored for your site.

#!/bin/sh

ORACLE_HOME=/opt/PATROL3-4/ora815
ORA_OWNER=patrol
ORACLE_SID=BMCEDS

export ORACLE_HOME ORA_OWNER ORACLE_SID

if [! -f $ORACLE_HOME/bin/oraadm]
then
echo "BMCEDS startup: cannot start"
exit
fi
case "$1" in
'start')
# Start the BMCEDS databases:

su - $ORA_OWNER -c $ORACLE_HOME/bin/oraadm start &
su - $ORA_OWNER -c $ORACLE_HOME/bin/lsnrctl start LISTENER
&
;;

'stop')
# Stop the BMCEDS database:
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su - $ORA_OWNER -c $ORACLE_HOME/bin/oraadm immediate &
;;
esac

# you will have to create these entries in the appropriate directory:

# ln -s /etc/init.d/bmcora /etc/rc0.d/K10bmcora
# ln -s /etc/init.d/bmcora /etc/rc2.d/S99bmcora

Automate Database Startup and Shutdown (Optional)

You can configure your system to automatically start Oracle database
when your system starts up and to shut down Oracle databases when
your system shuts down. Automating database startup is optional, bu
automatic shutdown is recommended because it guards against impr
shutdown of the database.

Theoraadm start andoraadm immediate scripts are located in
the$ORACLE_HOME/bindirectory and can be used to automate databa
startup and shutdown.

Theoraadm start andoraadm immediate  scripts reference the
same entries in theoratab  file, so the scripts must apply to the same s
of databases. For example, you cannot haveoraadm start
automatically start up databasessid1 , sid2 , andsid3 , andoraadm
immediate  shut down only databasessid1  andsid2 . You can,
however, specify thatoraadm immediate  shut down a set of databases
while oraadm start  is not used at all. To do this, include theoraadm
immediate  entry in the shutdown file but omit theoraadm start
entry from the system startup files.

Note
For a description of system startup and shutdown procedures, check 
init command in your Sun SPARC Solaris documentation.
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This process must be completed for every new database that you wa
configure for automated startup and shutdown. Perform the following
tasks to set up theoraadm start andoraadm immediate scripts so
that they are called at system startup:

Step 1 Edit the/var/opt/oracle/oratab  file.

Database entries in the oratab file appear in the following format:

ORACLE_SID:ORACLE_HOME:{Y|N}

whereY or N specifies whether you want theoraadm start  and
oraadm immediate scripts to start up and shut down the database. Fi
the entries for all the databases that you want to start up. They are
identified by thesid in the first field. Change the last field for each toY.

Step 2 Create a file nameddbora  in the/etc/init.d  directory (if it does not
already exist).

Step 3 Create entries similar to the following at the end of thedbora file (if they
do not already exist). Be sure to give the full path of theoraadm start
utility.

#!/bin/sh

# SetORA_HOME to be equivalent to theORACLE_HOME

# from which you wish to execute oraadm start  and

# oraadm immediate

# setORA_OWNER to the user id of the owner of the

# Oracle database in ORA_HOME

ORA_HOME=/u01/app/oracle/product/8.1.7

ORA_OWNER=oracle

if [! -f $ORA_HOME/bin/oraadm start]
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then

echo "Oracle startup: cannot start"

exit

fi

case "$1" in

'start')

# Start the Oracle databases:

# The following command assumes that the oracle login will not prom
the

# user for any values

su -$ORA_OWNER -c $ORA_HOME/bin/oraadm start &

;;

'stop')

# Stop the Oracle databases:

# The following command assumes that the oracle login will not prom
the

# user for any values

su -$ORA_OWNER -c $ORA_HOME/bin/oraadm immediate &
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esac

Step 4 Link dbora by entering:

# ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora

# ln -s/etc/init.d/dbora /etc/rc2.d/S99dbora
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Troubleshooting A

This appendix provides information on tips, problems, and issues and
when possible, recommends solutions.

The information is organized into broad categories. However, the sam
issue appears in multiple locations when appropriate. You will find
information grouped in the following categories:

Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A
Collection/DataStore/Aggregator/Retrievers . . . . . . . . . . . . . . . A-
Reporting/Report Server/Web/QuickReport Editor . . . . . . . . . . A-
General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A
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Troubleshooting Tips
Table A-1 lists recommendations for dealing with installation, collectio
reporting, and general Service Reporting issues.

Table A-1 Service Reporting Troubleshooting  (Part 1 of 9)

Tips/Problems/Issues Recommendations

Installation

Pre-Installation tips PATROL and PATROL Agents must be installed before
installing Service Reporting.

The PATROL Console is installed nearby but not on the
computer where the DataStore and Report Server will be
installed.

The computer where the DataStore and Report Server will be
installed must be running a clean NT 4.0 Server.

Oracle must not be currently installed on the computer where
the DataStore and Reporting components will be installed.

Use the CD to install all Service Reporting components (as
opposed to remote installs) when possible.

You must be licensed for both Lotus Domino, Oracle, and
Exchange to access the Solution Reports for Lotus Domino,
Oracle, and Exchange.

Create a mirror image of your computer drives before
installing Service Reporting. If you have problems, you can
quickly and easily restore the original image.
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Installation fails If installation fails, check the *ISI.log, machine-nameISI.log
(Windows NT) or InstallLog_machine-name-plus-PID (Unix),
to locate where the failure occurred. These log files identify
what components were installed and where the installation
failed. Return to the installation program and attempt to
re-install the components that failed.

In Windows NT the *ISI.log file is located in
%USERPROFILE%/Application Data/PatrolInstall .

In Unix, the *.ISI log file is located in the
$PATROL_HOME$/patrolinstall/logs  directory.

Use the mirror image you created before attempting to install
to quickly and easily restore the original image.

Installation appears to succeed but
application fails to run

Restart your system.

Report Server installs but the
QuickReport Editor is not available.

If the Report Server is installed and the QuickReport Editor is
unavailable, check the Web Agent for problems. Reinstall just
the QuickReports.

Check to see if you have upgraded Microsoft Java Virtual
Machine (JVM).

Collection/DataStore/Aggregator/Retrievers

Problems issuing common SQL
queries to the DataStore

Refer to the DataStore Administrator Guide or the Oracle8i
Error Messages.

DataStore Server performance
problems.

Do not install both database components (DataStore Client
Only and DataStore Server and DataStore Client) when you
are installing on one machine only. Doing so results in
problems using the DataStore Server. Select only the
DataStore Server and DataStore Client option.

Aggregator and retrievers fail to
start after installation

Upon installation, Auto Restart of the aggregator and
retrievers is set to "Yes" and they will attempt to start.
However, since there is no configuration information there,
they will fail to start.

Unable to establish communication
between the Report Server and the
DataStore.

You must install the DataStore client on the Windows NT
computer.

Table A-1 Service Reporting Troubleshooting  (Part 2 of 9)

Tips/Problems/Issues Recommendations
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Unable to obtain data from a
monitored computer

Make sure you can ping the aggregator and retriever
machines from each other. If you cannot ping the name of
your Unix box, you probably cannot obtain any data from it.

From the aggregator computer:

ping the retriever computer using the name that is displayed
in the DataStore Console, not what you think it is.

From the retriever computer:

ping the aggregator computer using the name that you
entered  in the configuration panel, not what you
think it is.

From the server computer:

ping the retriever computer the way it is entered  in the
configuration panel, not what you
think it is.

To look for error messages Using the PATROL Console, right click on SR_DATASTORE
=> KM COMMANDS => ADMINISTRATION =>
EventRET_portnumber or (HistoryRet_portnumber)
=> WATCH LOG.

The default port is 3181 for PATROL 3.4 and higher.

You may have to change the logging level to get the
information you need. (See Table 6-1, “Data Collection
Configuration Steps,” on page 6-4.)

No data appears to be getting into
Service Reporting

This problem occurs when there is no Knowledge Module
loaded by an Agent and there are no consoles connected to
the PATROL Agent.

You can customize the PATROL Console so that the
Knowledge Module is preloaded.

Connect to the Agent and leave it up all day. You can check
the following day to make sure data is getting to Service
Reporting.

Table A-1 Service Reporting Troubleshooting  (Part 3 of 9)

Tips/Problems/Issues Recommendations
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Do NOT create history filter using all
wildcards (/*/*/*/*)

Only create history filters to collect data for which there are
Solution Reports. Collecting all data increases the size of the
database and slows collection.

The default history filters collect all the parameters for the
Solution Reports. The only reason to create additional history
filters is to collect data for custom reports. If you create
custom reports using the QuickReport Editor report templates,
you should define history filters to capture only the data for the
custom reports.

Capturing data which is not used in any report is a waste of
resources, since reports are the only way to see the data
collected.

Oracle Reports missing data points.
The problem can result from the
agent not writing history data for
those parameters to the agent
history-file until much later than
expected. The issue has to do with
how often the agent flushes its data
to the history-file.

It may be as easy as setting a pconfig variable in the agent to
force more frequent history writes.

Reporting/Report Server/Web/QuickReport Editor

Cannot access your Web Server Restart your Web Server. To do so, go to a MS-DOS window
and at the DOS prompt, specify the following:
• NET STOP IISADMIN, then
• NET START W3SVC

Report Server installs but the
QuickReport Editor is not available.

If the Report Server is installed and the QuickReport Editor is
unavailable, check the Web Agent for problems. Reinstall just
the QuickReports.

Check to see if you have upgraded Microsoft Java Virtual
Machine.

Cannot access the QuickReport
Editor

Access to the QuickReport Editor
is only allowed through the Service Reporting Web Desktop.
Click the Administration tab and then the QuickReport Editor
tab to access the QuickReport Editor.

Table A-1 Service Reporting Troubleshooting  (Part 4 of 9)

Tips/Problems/Issues Recommendations
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Unable to open the QuickReport
Editor

If you are using NTFS, you may have trouble opening the
QuickReport Editor. NTFS does not automatically know the
PATROL user that PATROL created. The PATROL
Administrator must give the PATROL user permission to use
the files.

Renaming Folders in the
QuickReport Editor

When using the Browse dialog box from the QuickReport
Editor in this current version, you cannot rename any folder
that contains report templates. BMC Software recommends
renaming the default NewFolder immediately, before storing
any report templates in it.

You must press Enter after renaming a folder to save the
changed name.

IE doesn’t download and install the
Java plug-in when it encounters a
converted page

Make sure the CODEBASE in the OBJECT tag has the
correct URL for the Java Plug-in Software. Also, turning off
execute privileges on the directory in which you put the Java
Plug-in Software executable may help.

Poor performance when generating
multiple reports

Refer to the Actuate document, Administering the Report
Encyclopedia, for creating multiple process groups.

Unable to establish communication
between the Report Server and the
DataStore

You must install the DataStore client on the Windows NT
computer.

Table A-1 Service Reporting Troubleshooting  (Part 5 of 9)

Tips/Problems/Issues Recommendations
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Blank reports A blank report indicates that the DataStore doesn't have any
data related to this report. Relevant question to ask include:

On the PATROL side:

• Is PATROL KM installed and running?

• Is the parameter associated with the desired report turned
on in PATROL and History able?

• Is the PATROL Agent running?

• Is the History Retriever for the specified parameter turned
on?

On the DataStore side:

• Is the Retriever running and configured?

• Is there a filter set for the specified parameter?

• Is the Aggregator running and are summaries being created
for the specified time span?

Labels do not appear on Trend
Graphs

View graphs at 75% or higher. If you view reports at 75% or
lower, labels on graph may not appear.

Restarting Actuate Services when
restarting

When you restart your computer, the Actuate Services you
need for Service Reporting are set to automatically restart. If
you get a message saying that the services have not
restarted, it’s possible that Windows NT timed out before the
services restarted, generating the message.
To verify that the services are running

Right-click the Taskbar. Choose Task Manager  =>
Processes .

Or

Choose Start => Settings => Control Panel =>
Services .

Table A-1 Service Reporting Troubleshooting  (Part 6 of 9)

Tips/Problems/Issues Recommendations
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Monitor Report Server space You must actively monitor the available disk space on the drive
partition where the Report Server is installed. If reports are
being created on an ongoing basis, and old reports are never
deleted, then the disk requirements for the Report Server will
grow without bound. To monitor a disk partition's available
space, go to Windows NT Explorer or My Computer, highlight
the logical disk, then choose File => Properties .

Monitor the Report Encyclopedia The administrator needs to clean up extraneous items in the
Report Encyclopedia. Attempting to create a report instance in
the Report Encyclopedia leaves an entry in the
Requests\Completed folder. If the attempt was successful,
then the report is stored in the directory structure visible
through the Administrator's Desktop (see the Administering
the Report Encyclopedia). Periodic cleanup of the entries in
the Requests\Completed folder reduces disk space
requirements and permits more efficient management of the
Report Server.

View and manage log files Log files are created in the path specified by the Logfile
property in the configuration files (Admin Section) section.
There is a Log File Cleanup Tool that deletes the log files
generated by Service Reporting. The file cleanup reports
(daily, weekly, monthly), scheduled on installation to run at
specific intervals, are located in BMCReports/Cleanup . For
more information, see “Using the Log File Cleanup Tool” on
page 6-17.

Table A-1 Service Reporting Troubleshooting  (Part 7 of 9)

Tips/Problems/Issues Recommendations
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Oracle reports run. Not all hourly
data points are accounted for.

This might occur if the agent doesn’t write history data for
those parameters to the agent history file until much later than
Service Reporting expects to receive and report on them. The
problem appears to be a bug in versions of PATROL earlier
than 3.4.11 that prevents some infrequently read parameters
from being written to PATROL's history database file in a
timely manner.  The data does get there eventually, but too
late for the summaries on the Aggregator.

To determine if this is your problem, see if the data that is
missing in the reports is missing in the DataStore by using the
charts on the Data tab of the DataStore Console.  If you find
the corresponding parameter in the data hierarchy, right-click it
and select History Chart => Hourly => Average . Make sure
that the correct timespan is set for the chart in Options
=>Preferences . You will see a chart like the report, missing
the data points.

Then check the raw data by right-clicking the parameter again,
and choosing History Chart => Raw .  You will see all the
data, with no gaps.

Upgrading from PATROL 3.4.11 should eliminate the problem.

General

PATROL restarts services that you
are trying to stop.

BMC Software recommends setting Auto-Restart to Off or
disabling the services (SR_DataStore) through Start =>
Settings => Control Panel => Services .

The Backup/Recovery utility fails When PATROL restarts services that you are trying to stop, it
might interfere with the Backup/Recovery utility.

BMC Software recommends setting Auto-Restart to Off or
disabling the services (SR_DataStore) through Start =>
Settings => Control Panel => Services .

Table A-1 Service Reporting Troubleshooting  (Part 8 of 9)

Tips/Problems/Issues Recommendations
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To produce error files for Customer
Support

• Make sure logging level is set to three for the aggregator
and a history retriever. (See Table 6-1, “Data Collection
Configuration Steps,” on page 6-4.)

• Let the log run for about two minutes and shutdown the
aggregator and history retriever. The log names for the
aggregator and the history retriever are:

• the aggregator-nodename.trace for the aggregator
• the historyretriever-nodename-portnumber.0 and .1 files for

the historyretriever.
• Use the most current logs located in patrol_home\log

directory.

Do I need to install a PATROL Agent
on the PATROL Console computer?

Only if you intend to install retrievers and/or an aggregator on
your Console computer.

Receive Error Message (500) when
using the product

To avoid Error 500 when using Windows NTFS security, make
sure that one of the following is true:

~ Your NTFS settings are Full, All, All, All
or
~ The anonymous IIS user has equivalent permissions

View and manage log files Log files are created in the path specified by the Logfile
property in the configuration files (Admin Section) section.
There is a Log File Cleanup Tool that deletes the log files
generated by Service Reporting. The file cleanup reports
(daily, weekly, monthly), scheduled on installation to run at
specific intervals, are located in BMCReports/Cleanup . For
more information, see “Using the Log File Cleanup Tool” on
page 6-17.

Diagnostic tests There is a set of diagnostic tests you can run as long as you
have a Web Server up and running. Please run the diagnostic
tests before calling Customer Support.
Go to the following URL and select the diagnostic tests you
want to run.
machine
name/bmcscripts/installverification/installverification.html

Table A-1 Service Reporting Troubleshooting  (Part 9 of 9)

Tips/Problems/Issues Recommendations
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This appendix lists related Actuate and Oracle documentation that can
used in conjunction with Service Reporting. These Actuate and Oracl
documents are found on the Service Reporting Documentation CD.

Service Reporting Related Documentation  . . . . . . . . . . . . . . . . . . . B
Actuate Software Corporation Documentation . . . . . . . . . . . . . B-
Oracle Corporation Documentation. . . . . . . . . . . . . . . . . . . . . . B
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Service Reporting Related Documentation
Table B-1 and Table B-2 list the documentation for the Actuate Softwa
Corporation components and Oracle Corporation components of Ser
Reporting. These documents are formatted as Portable Document Fo
(PDF) files on the Service Reporting Documentation CD.

Actuate Software Corporation Documentation

Table B-1 Actuate Documentation

Document Description

Administering the Report
Encyclopedia

provides information about managing users,
groups, roles, privileges, printers, process
groups, and print requests

Using e.Reports describes the tasks you can perform with
reports that have been designed, compiled,
and generated—includes using e.reports on
the Web or a desktop, viewing and running a
report, searching for and exporting data,
printing and distributing a report

Viewing e.Reports describes the tasks you can perform using the
Actuate Viewer—includes the same topics as
Using e.Reports except for running a report

LRX for Microsoft Internet
Explorer

describes the tasks you can perform using
Microsoft Internet Explorer in combination with
the Actuate LRX

LRX for Netscape Navigator describes the tasks you can perform using
Netscape Navigator in combination with the
Actuate LRX

Building an e.Reporting Web
Site

provides information on accessing the Actuate
Report Encyclopedia on the World Wide Web

e.Reporting Server Guide provides information about managing the
interaction between client and server to enable
activities such as scheduling and running
reports
BMC Software, Inc., Confidential and Proprietary Information

B-2 Service Reporting Getting Started



Oracle Corporation Documentation

Table B-2 Oracle Documentation

Document Description

Oracle8i Installation
Release 8.1.5 for Windows NT and
Windows 95/98

provides instructions for uninstalling
Oracle8i for Windows NT Release 8.1.5

Oracle8i Installation Guide Release
2 (8.1.6) for Sun SPARC Solaris

provides instructions for uninstalling
Oracle8i Release 2 (8.1.6) on Sun
SPARC Solaris systems

Oracle8i Error Messages describes the error messages that may
appear while using Oracle products
BMC Software, Inc., Confidential and Proprietary Information
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Service Reporting Component List C

This appendix lists the components of Service Reporting that you can
install onto Windows NT and Windows 2000 and Unix operating
systems.

Windows NT and Windows 2000 Installation Component List . . . . C-
Unix Installation Component List  . . . . . . . . . . . . . . . . . . . . . . . . . . C-
BMC Software, Inc., Confidential and Proprietary Information
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Windows NT and Windows 2000 Installation
Component List

Table C-1 lists the components of Service Reporting that you can ins
onto the Windows NT and Windows 2000 operating system.

Table C-1 Windows NT and Windows 2000 Installation Component List  (Part 1 of 3)

Component Description

Install Data Collection Components

Aggregator Console KM Aggregator section of the DataStore KM that configures and
monitors the data aggregator. The Aggregator Console KM
must be installed on the Windows NT and Windows 2000
computer where the PATROL Console is running. This lets
you configure aggregators on PATROL Agent computer(s).

Retrievers Console KM Retriever section of the DataStore KM that configures and
monitors event and history retrievers. The Retrievers
Console KM must be installed on the computer where the
PATROL Console is running. This lets you configure
retrievers on PATROL Agent computer(s).

Aggregator Data collection component which receives event and
parameter data from retrievers to forward and summarize in
the DataStore.

Retrievers Data collection component that retrieves parameter and
event data from a PATROL Agent. Retrievers must be
installed onto a PATROL Agent computer.

DataStore Console Interface to the DataStore used to determine what data is
collected as well as monitor and maintain the data
aggregators and retrievers in your environment. The
DataStore Console does not need to be installed onto a
PATROL Agent.

Install Reporting Components

Administrator Desktop for NT Interface for managing the Report Server to schedule report
generation, view reports, print reports, and set up privileges
to view reports.

QuickReport Editor Utility that is used to create new reports based on generic
report templates to meet your management reporting
requirements. A series of dialogs help you define the input
parameters for your report.
BMC Software, Inc., Confidential and Proprietary Information
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Report Server for NT Reporting component responsible for generating reports
using data from the DataStore and communicating with
clients for report viewing and printing. It also manages and
controls user roles and access.

IIS Web Agent for NT Utility that enables Microsoft IIS web server to access the
Report Server from world wide web.

Service Reporting Studio Reporting tool you can use in conjunction with the DataBase
Schema to compose your own graphs of PATROL
Knowledge Module data.

Netscape Web Agent for NT Utility that enables Netscape Web Server to access the
Report Server from the world wide web.

Solution Reports for Exchange and
Exchange 2000

A predefined set of report templates created specifically for
Microsoft Exchange and Exchange 2000. It provides
information on service management, enterprise resource
management, and other requirements specific to Microsoft
Exchange and Exchange 2000.

Solution Reports for Lotus Domino A predefined set of report templates created specifically for
Lotus Domino. It provides information on service
management, enterprise resource management, and other
requirements specific to Lotus Domino.

Solution Reports for NT A predefined set of report templates created specifically for
Windows NT and Windows 2000. It provides information on
service management, enterprise resource management, and
other requirements specific to Windows NT and Windows
2000.

Solution Reports for Oracle A predefined set of report templates created specifically for
Oracle. It provides information on service management,
enterprise resource management, and other requirements
specific to Oracle.

Solution Reports for Unix A predefined set of report templates created specifically for
Unix. It provides information on service management,
enterprise resource management, and other requirements
specific to Unix.

Install Database Components

Table C-1 Windows NT and Windows 2000 Installation Component List  (Part 2 of 3)

Component Description
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Unix Installation Component List
Table C-2 lists the components of Service Reporting that you can ins
on a Unix computer.

DataStore Client Only Utility that connects the Report Server to the DataStore
when the DataStore is installed on a separate computer. The
DataStore Client needs to be installed on the same
computer as the Report Server for Windows NT.

DataStore Server & DataStore Client Database used to store parameter and event data collected
by data collection components, including retrievers. Use this
option when the Report Server and DataStore are installed
on the same Windows NT and Windows 2000 computer. The
DataStore Server uses an Oracle relational database
management system.

Table C-2 Unix Installation Component List

Component Description

Install Data Collection Components

Aggregator Console KM Aggregator section of the DataStore KM that configures and
monitors the data aggregator. The Aggregator Console KM
must be installed on the Windows NT and Windows 2000
computer where the PATROL Console is running. This lets
you configure aggregators on PATROL Agent computer(s).

Retrievers Console KM Retriever section of the DataStore KM that configures and
monitors event and history retrievers. The Retrievers
Console KM must be installed on the computer where the
PATROL Console is running. This lets you configure
retrievers on PATROL Agent computer(s).

Aggregator Data collection component which receives event and
parameter data from retrievers to forward and summarize in
the DataStore.

Retrievers Data collection component that retrieves parameter and
event data from a PATROL Agent. Retrievers must be
installed onto a PATROL Agent computer.

Table C-1 Windows NT and Windows 2000 Installation Component List  (Part 3 of 3)

Component Description
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Install Reporting Components

QuickReport Editor Utility that is used to create new reports based on generic
report templates to meet your management reporting
requirements. A series of dialogs help you define the input
parameters for your report.

Report Server for Sun Solaris Reporting component responsible for generating reports
using data from the DataStore and communicating with
clients for report viewing and printing. It also manages and
controls user roles and access.

Netscape Web Agent for Unix Utility that enables Netscape Web Server to access the
Report Server from the world wide web.

Solution Reports for Exchange and
Exchange 2000

A predefined set of report templates created specifically for
Microsoft Exchange and Exchange 2000. It provides
information on service management, enterprise resource
management, and other requirements specific to Microsoft
Exchange and Exchange 2000.

Solution Reports for Lotus Domino A predefined set of report templates created specifically for
Lotus Domino. It provides information on service
management, enterprise resource management, and other
requirements specific to Lotus Domino.

Solution Reports for NT A predefined set of report templates created specifically for
Windows NT. It provides information on service
management, enterprise resource management, and other
requirements specific to Windows NT.

Solution Reports for Oracle A predefined set of report templates created specifically for
Oracle. It provides information on service management,
enterprise resource management, and other requirements
specific to Oracle.

Solution Reports for Unix A predefined set of report templates created specifically for
Unix. It provides information on service management,
enterprise resource management, and other requirements
specific to Unix.

Install Database Components

Table C-2 Unix Installation Component List

Component Description
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DataStore Server Database used to store parameter and event data collected
by data collection components, including retrievers. Use this
option when the Report Server and DataStore are installed
on the same Windows NT and Windows 2000 computer. The
DataStore Server uses an Oracle relational database
management system.

DataStore Instance An occurrence of the DataStore database residing on a
server.

Table C-2 Unix Installation Component List

Component Description
BMC Software, Inc., Confidential and Proprietary Information

C-6 Service Reporting Getting Started



Glossary

not

e

o,
)

gs

,

d

Glossary

Actuate Live Report
Extension (LRX)

A Web browser plug-in that an end user can use to find, view,
and print reports accessed over the Internet. This feature can
be used to generate reports.

Administrator Desktop Interface for managing the Report Server. Used to schedule
report generation, view reports, print reports, and set up
privileges to view reports.

aggregator A Service Reporting component that compiles the information
collected from one or more retrievers and stores the data in th
DataStore as raw and summarized data.Seedata aggregator.

application class The object class to which an application instance belongs; als
its representation as a container (Unix) or folder (Windows NT
on the PATROL Console. You can use a PATROL Developer
Console to add or change application classes.

application instance A system resource discovered by PATROL. Contains the
information and attributes of the application class that it belon
to. See also application class, and instance.

associations A way to classify related namespace data (application classes
application instances, and parameters) used for a common
purpose. Data can be associated by location, organization, an
category.
BMC Software, Inc., Confidential and Proprietary Information
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component The subject of a measurement or event. Examples in PATROL
include

• an Oracle database instance
• a host running a Windows NT server

data aggregator A data aggregator receives event and parameter data from
retrievers. It also forwards that data to the DataStore. Data
aggregators control the DataStore’s summarizing activities,
normalize and synchronize time values between different data
sources, control and monitor a retriever’s status, and downloa
configuration parameters to a retriever.

data summarization A process that converts raw data located in the DataStore into
summary data. When raw data is converted, it is organized int
hourly, daily, weekly, and monthly summary time periods with
summary values of maximum, average, and sum. The
summarized data can be used by the QuickReport Editor and
Solution Reports.

DataStore The DataStore is the database used by Service Reporting to s
parameter and event data collected from your PATROL
environment. This data is stored as raw data, measurement
values, and time-summarized measurements. Time-summariz
measurements are the inputs to reports.

DataStore Console The DataStore Console is the graphical user interface (GUI) f
the DataStore. With the DataStore Console, you can determin
what data is collected. You can also monitor and maintain
aggregators and retrievers.

DataStore KM The knowledge module (KM) that Product Name uses to
configure and monitor DataStore components, including data
aggregators and retrievers. The DataStore KM lets you config
local or remote data aggregators and retrievers. You can also
start, stop, and monitor the current status or performance of th
components.SeeKnowledge Module (KM).

drill down While viewing a report, the ability to view the same informatio
in more detail as part of the same report.
BMC Software, Inc., Confidential and Proprietary Information
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dump_hist utility A command line utility that lets you save parameter history da
from databases on PATROL Agents to ASCII text files.

enterprise All the components, measurements, and events in the PATRO
Datastore valid for a given time.

enterprise view A subset of the components, measurements, and events store
the DataStore for a given time span. For example, an enterpri
view might include:

• all Windows NT nodes located in Houston and their KM
parameter values for yesterday

• all Microsoft Exchange servers on nodes whose name sta
“hou” and their Exchange KM parameter TotalMsgSize
averaged daily for the last week

event filter Created in the DataStore Console, an event filter controls the
collection of event data. An event filter may contain type, statu
and severity criteria. With an event filter, you can specify the
information, state change, error, and warning events that you
want to collect.

event retriever A component that collects data when an event matches criteri
specified in the event filter. Once the event occurs, the event
retriever forwards the raw event data to the data aggregator.

Factory An internal tool that generates an e.report for viewing. The
Factory follows the instructions in a report executable file
(.ROX) file to generate a report (.ROI).

filters A filter is used to determine what information is collected.
Product Name uses the following filters:

• history filters—used to collect parameter information
• event filters—used to collect event information

generic report In the QuickReport Editor, a presentation (graph, table, or cha
generated by specifying parameters, selection criteria, and lab
BMC Software, Inc., Confidential and Proprietary Information
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history filter A history filter lets you specify what parameter data is collecte
from a PATROL Agent. With a history filter, you can specify a
subset of the parameter data collected by the KMs installed o
the agent being queried.

history retriever A process that collects parameter information from an agent’s
local cache.

initialize To provide a set of definitions and instructions as a starting po
for a component or executable. These settings can normally b
redefined at any point.

instance A computer or discovered application that is running in the
PATROL-managed environment. An instance has all the
attributes of the class that it belongs to. A computer instance i
monitored computer that has been added to the PATROL
Console. An application instance is discovered by PATROL.See
application instance.

interval type A specified time unit. A time unit can be an hour, a day, a wee
a month, or a year.

KM See Knowledge Module (KM).

KM list A list of KMs to be loaded by a PATROL Agent.See also
Knowledge Module (KM).

KM tree A feature of PATROL for Windows NT only. One of two views of
folders available in Windows NT. The KM tree displays
computer classes, application classes, and their customized
instances in the knowledge hierarchy. It also displays the
Standard Event Catalog. The KM tree can be viewed with a
PATROL Operator Console. To change KM properties and
attributes, you must use the PATROL Developer Console.See
also Knowledge Module (KM).
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Knowledge Module
(KM)

A set of files from which a PATROL Agent receives information
about resources running on a monitored computer. A KM file ca
contain the actual instructions for monitoring objects or simply
list of KMs to load. KMs are loaded by a PATROL Agent and a
PATROL Console.

KMs provide information for

• the way monitored computers are represented on the
PATROL Desktop

• the discovery of application instances and the way they ar
represented

• parameters that are run under those applications
• the options available on object menus

A PATROL Developer Console can change KM knowledge for
its current session, save knowledge for all of its future session
and commit KM changes to specified PATROL Agent
computers.See also KM list, KM tree, and load KMs.

load applications Same as load KMs; most KMs are composed of application fil
with a* .kml  extension.

load KMs To place KM files into memory for execution. After
configuration and during startup, the PATROL Agent loads the
KM files that are listed in its configuration file and that reside o
the PATROL Agent machine. When a PATROL Console
connects to the PATROL Agent, the KM versions that the Age
executes depend on whether the Console is an Operator Con
or a Developer Console.See also Knowledge Module (KM).

local history The history (stored parameter values) for an object or instanc

local history retention
period

The user-defined length of time during which stored paramete
values for an object or instance are retained.

manual collection Lets you start or stop collection of parameter data regardless 
the settings in a history filter. Manual collection lets you be ve
specific about the data being collected. Once you use manua
collection, those settings remain in effect until you clear them.
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open data retriever Process that reads a comma separated value file and lets you
dump_hist data into the DataStore.See retrievers.

QuickReport Editor A graphical user interface that uses generic report templates 
create new reports. A series of dialogs help you define the inp
parameters for your report.

QuickReport Template One of several report definitions or templates that a user can
select to generate a specific report. The definition includes

• a visual presentation and a list of namespaces that control
presentation

• a family of content and a list of required namepaces to
specify the content

For example, the top/bottom N summary graph defines the vis
presentation as a bar graph and defines the input as at the mo
rows of data, sorted in ascending or descending order.

report Generated presentations (graphs, tables, or charts) based on
stored PATROL event and parameter data that you can view
remotely using a Web browser on supported platforms.

report consumer Person who locates, runs, schedules, and views report
documents. Typically, this person is a manager or senior IT
professional in charge of managing a portion of the enterprise
infrastructure.

report composer A person who creates schedules and runs report templates,
creates new report templates, and ensures that the necessary
is being collected. Typically, this person is a technical IT
professional who needs certain kinds of PATROL information 
appear in reports.
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Report Server Reporting component responsible for generating reports using
data from the DataStore and communicating with clients for
report viewing and printing. It also manages and controls user
roles and access. With the report server, you can:

• manage users request (on-demand reports with run-time
parameters)

• control the report encyclopedia and validate users and
requests

• generate report instances
• print reports
• manage persistent objects, such as report instances, folde

users, and roles

report store
administrator

A person who installs components, configures components, a
periodically cleans up the report store/encyclopedia (for
example, archiving old reports, removing old reports, or
removing unused report templates).

report template Report templates (RTs) are definitions that direct Service
Reporting to extract data from the DataStore for a given time
span and generate a presentation in the form of a graph, table
chart.

retrievers Components that compile, filter, and forward agent data to an
aggregator. Aggregators send filter settings to the retrievers th
specify which parameter data and event data to collect. Produ
Name includes the following types of retrievers:

• History Retriever—collects parameter data from an agent’
local cache

• Event Retriever—collects event data
• Open Data Retriever—reads a comma separated value fil

and lets you loaddump_hist  data into the DataStore

.ROI files A file that contains a viewable and printable report. ROI is an
acronym for the Actuate termreport object instance. ROI files
are stored in the Report Encyclopedia. You can use the End U
Desktop or the Administrator Desktop to create report docume
files.
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.ROV files A file that contains parameter values used by the Factory to
generate the e.report. ROV is an acronym for the Actuate term
report object value. These files store parameter values specifi
for a specific report executable. The values in the file filter the
data for a report document. A parameter values file is
automatically created when users run the report.

.ROX files A file that contains the instructions for generating and viewing
report object. ROX is an acronym for the Actuate termreport
object executable. When executed, these files generate report
documents with current data.

Solution Reports A package of report templates created for the management o
particular technology or application. Solution Reports require
little or no user setup.

threshold A point or points that define a range of values, outside of whic
a parameter is considered to be in a warning or alarm range.

time span A particular interval defined by its interval type and start time,
for example, week of January 10, 2001.

time span type For simple time spans, the interval type. For nested time span
the interval type and number of sub-intervals, for example,
weekly span shown as 168 hours.

Web Desktop The component of Product Name that provides access to
reporting. Using the Web Desktop, you can view contents of th
Report Encyclopedia and create your own reports with the
QuickReport Editor. In general, the Web Desktop allows you t
generate, schedule, locate, view, print, and distribute reports.

Windows NT Viewer On Windows NT platforms, an application that an end user ca
use to print and view reports.
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STOP!

IMPORTANT INFORMATION - DO NOT INSTALL THIS PRODUCT UNLESS YOU HAVE
READ ALL OF THE FOLLOWING MATERIAL

By clicking the YES or ACCEPT button below (when applicable), or by installing and using this Product or by having it
installed and used on your behalf, You are taking affirmative action to signify that You are entering into a legal agreement and
are agreeing to be bound by its terms, EVEN WITHOUT YOUR SIGNATURE. BMC is willing to license this Product to You
ONLY if You are willing to accept all of these terms. CAREFULLY READ THIS AGREEMENT. If You DO NOT AGREE with its
terms, DO NOT install or use this Product; press the NO or REJECT button below (when applicable) or promptly contact BMC
or your BMC reseller and your money will be refunded if by such time You have already purchased a full-use License.

SOFTWARE LICENSE AGREEMENT FOR BMC PRODUCTS

SCOPE. This is a legally binding Software License Agreement ("License" ) between You (either an individual or an entity) and BMC
pertaining to the original computer files (including all computer programs and data stored in such files) contained in the enclosed Media
(as defined below) or made accessible to You for electronic delivery, if as a prerequisite to such accessibility You are required to
indicate your acceptance of the terms of this License, and all whole or partial copies thereof, including modified copies and portions
merged into other programs (collectively, the "Software" ). "Documentation" means the related hard-copy or electronically
reproducible technical documents furnished in association with the Software, "Media" means the original BMC-supplied physical
materials (if any) containing the Software and/or Documentation, "Product" means collectively the Media, Software, and
Documentation, and all Product updates subsequently provided to You, and "You" means the owner or lessee of the hardware on
which the Software is installed and/or used. "BMC" means BMC Software Distribution, Inc. unless You are located in one of the
following regions, in which case "BMC" refers to the following indicated BMC Software, Inc. subsidiary: (i) Europe, Middle East or Africa
--BMC Software Distribution, B.V., (ii) Asia/Pacific -- BMC Software Asia Pacific Pte Ltd., (iii) Brazil -- BMC Software do Brazil, or (iv)
Japan -- BMC Software K.K. If You enter into a separate, written software license agreement signed by both You and BMC or
your authorized BMC reseller granting to you the rights to install and use this Product, then the terms of that separate, signed
agreement will apply and this License is void.

FULL-USE LICENSE. Subject to these terms and payment of the applicable license fees, BMC grants You this non-exclusive License
to install and use one copy of the Software for your internal use on the number(s) and type(s) of servers or workstations for which You
have paid or agreed to pay to BMC or your BMC reseller the appropriate license fee. If your license fee entitles You only to a License
having a limited term, then the duration of this License is limited to that term; otherwise this License is perpetual, subject to the
termination provisions below.

TRIAL LICENSE. If You have not paid or agreed to pay to BMC or your BMC Reseller the appropriate license fees for a full use license,
then, NOTWITHSTANDING ANYTHING TO THE CONTRARY CONTAINED IN THIS LICENSE : (i) this License consists of a
non-exclusive evaluation license ("Trial License") to use the Product for a limited time ("Trial Period") only for evaluation; (ii) during the
Trial Period, You may not use the Software for development, commercial, production, database management or other purposes than
those expressly permitted in clause (i) immediately above; and (iii) your use of the Product is on an AS IS basis, and BMC, ITS
RESELLERS AND LICENSORS GRANT NO WARRANTIES OR CONDITIONS (INCLUDING IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE) TO YOU AND ACCEPT NO LIABILITY WHATSOEVER
RESULTING FROM THE USE OF THIS PRODUCT UNDER THIS TRIAL LICENSE. If You use this Product for other than evaluation
purposes or wish to continue using it after the Trial Period, you must purchase a full-use license. When the Trial Period ends, your right
to use this Product automatically expires, though in certain cases You may be able to extend the term of the Trial Period by request.
Contact BMC or your BMC reseller for details.

TERM AND TERMINATION. This License takes effect on the first to occur of the date of shipment or accessibility to You for electronic
delivery, as applicable (the "Product Effective Date" ). You may terminate this License at any time for any reason by written notice to
BMC or your BMC reseller. This License and your right to use the Product will terminate automatically with or without notice by BMC if
You fail to comply with any material term of this License. Upon termination, You must erase or destroy all components of the Product
including all copies of the Software, and stop using or accessing the Software. Provisions concerning Title and Copyright, Restrictions
(or Restricted Rights, if You are a U.S. Government entity) or limiting BMC's liability or responsibility shall survive any such termination.

TITLE AND COPYRIGHT; RESTRICTIONS. All title and copyrights in and to the Product, including but not limited to all modifications
thereto, are owned by BMC and/or its affiliates and licensors, and are protected by both United States copyright law and applicable
international copyright treaties. You will not claim or assert title to or ownership of the Product. To the extent expressly permitted by
applicable law or treaty notwithstanding this limitation, You may copy the Software only for backup or archival purposes, or as an
essential step in utilizing the Software, but for no other purpose. You will not remove or alter any copyright or proprietary notice from



copies of the Product. You acknowledge that the Product contains valuable trade secrets of BMC and/or its affiliates and licensors.
Except in accordance with the terms of this License, You agree (a) not to decompile, disassemble, reverse engineer or otherwise
attempt to derive the Software's source code from object code except to the extent expressly permitted by applicable law or treaty
despite this limitation; (b) not to sell, rent, lease, license, sublicense, display, modify, time share, outsource or otherwise transfer the
Product to, or permit the use of this Product by, any third party; and (c) to use reasonable care and protection to prevent the
unauthorized use, copying, publication or dissemination of the Product and BMC confidential information learned from your use of the
Product. You will not export or re-export any Product without both the written consent of BMC and the appropriate U.S. and/ or
foreign government license(s) or license exception(s). Any programs, utilities, modules or other software or documentation
created, developed, modified or enhanced by or for You using this Product shall likewise be subject to these restrictions. BMC has the
right to obtain injunctive relief against any actual or threatened violation of these restrictions, in addition to any other available
remedies. Additional restrictions may apply to certain files, programs or data supplied by third parties and embedded in the Product;
consult the Product installation instructions or Release Notes for details.

LIMITED WARRANTY AND CONDITION. If You have purchased a Full-Use License, BMC warrants that (i) the Media will be, under
normal use, free from physical defects, and (ii) for a period of ninety (90) days from the Product Effective Date, the Product will perform
in substantial accordance with the operating specifications contained in the Documentation that is most current at the Product Effective
Date. BMC's entire liability and your exclusive remedy under this provision will be for BMC to use reasonable best efforts to remedy
defects covered by this warranty and condition within a reasonable period of time or, at BMC's option, either to replace the defective
Product or to refund the amount paid by You to license the use of the Product. BMC and its suppliers do not warrant that the Product
will satisfy your requirements, that the operation of the Product will be uninterrupted or error free, or that all software defects can be
corrected. This warranty and condition shall not apply if: (i) the Product is not used in accordance with BMC's instructions, (ii) a Product
defect has been caused by any of your or a third party's malfunctioning equipment, (iii) any other cause within your control causes the
Product to malfunction, or (iv) You have made modifications to the Product not expressly authorized in writing by BMC. No employee,
agent or representative of BMC has authority to bind BMC to any oral representations, warranties or conditions concerning the Product.
THIS WARRANTY AND CONDITION IS IN LIEU OF ALL OTHER WARRANTIES AND CONDITIONS. THERE ARE NO OTHER
EXPRESS OR IMPLIED WARRANTIES OR CONDITIONS, INCLUDING THOSE OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, REGARDING THIS LICENSE OR ANY PRODUCT LICENSED HEREUNDER. THIS PARAGRAPH
SHALL NOT APPLY TO A TRIAL LICENSE. Additional support and maintenance may be available for an additional charge; contact
BMC or your BMC reseller for details.

LIMITATION OF LIABILITY. Except as stated in the next succeeding paragraph, BMC's and your BMC reseller's total liability for all
damages in connection with this License is limited to the price paid for the License. IN NO EVENT SHALL BMC BE LIABLE FOR ANY
CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE USE OF
THIS PRODUCT (SUCH AS LOSS OF PROFITS, GOODWILL, BUSINESS, DATA OR COMPUTER TIME, OR THE COSTS OF
RECREATING LOST DATA), EVEN IF BMC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Some jurisdictions
do not permit the limitation of consequential damages so the above limitation may not apply.

INDEMNIFICATION FOR INFRINGEMENT. BMC will defend or settle, at its own expense, any claim against You by a third party
asserting that your use of the Product within the scope of this License violates such third party's patent, copyright, trademark, trade
secret or other proprietary rights, and will indemnify You against any damages finally awarded against You arising out of such claim.
However, You must promptly notify BMC in writing after first receiving notice of any such claim, and BMC will have sole control of the
defense of any action and all negotiations for its settlement or compromise, with your reasonable assistance. BMC will not be liable for
any costs or expenditures incurred by You without BMC's prior written consent. If an order is obtained against your use of the Product
by reason of any claimed infringement, or if in BMC's opinion the Product is likely to become the subject of such a claim, BMC will at its
option and expense either (i) procure for You the right to continue using the product, or (ii) modify or replace the Product with a
compatible, functionally equivalent, non-infringing Product, or (iii) if neither (i) nor (ii) is practicable, issue to You a pro-rata refund of
your paid license fee(s) proportionate to the number of months remaining in the 36 month period following the Product Effective Date.
This paragraph sets forth your only remedies and the total liability to You of BMC, its resellers and licensors arising out of such claims.

GENERAL. This License is the entire understanding between You and BMC concerning this License and may be modified only in a
mutually signed writing between You and BMC. If any part of it is invalid or unenforceable, that part will be construed, limited, modified,
or, severed so as to eliminate its invalidity or unenforceability. This License will be governed by and interpreted under the laws of the
jurisdiction named below, without regard to conflicts of law principles, depending on which BMC Software, Inc. subsidiary is the party to
this License: (i) BMC Software Distribution, Inc. - the State of Texas, U.S.A., (ii) BMC Software Distribution, B.V. - The Netherlands, (iii)
BMC Software Asia Pacific Pte Ltd. -- Singapore (iv) BMC Software do Brazil -- Brazil, or (v) BMC Software K.K. -- Japan. Any person
who accepts or signs changes to the terms of this License promises that they have read and understood these terms, that they have
the authority to accept on your behalf and legally obligate You to this License. Under local law and treaties, the restrictions and
limitations of this License may not apply to You; You may have other rights and remedies, and be subject to other restrictions and
limitations.

U.S. GOVERNMENT RESTRICTED RIGHTS. UNPUBLISHED -- RIGHTS RESERVED UNDER THE COPYRIGHT LAWS OF THE
UNITED STATES. Use, duplication, or disclosure by the U.S. Government is subject to restrictions set forth in FAR Section 52.227-14
Alt. III (g)(3), FAR Section 52.227-19, DFARS 252.227-7014 (b) or DFARS 227.7202, as amended from time to time.
Contractor/Manufacturer is BMC Software, Inc., 2101 CityWest Blvd., Houston, TX 77042-2827, USA. Any contract notices should be
sent to this address.
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